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• Dokument so aufbewahren, dass das Dokument bei Arbeiten am und mit dem Gerät
jederzeit verfügbar ist.

• Um eine Gefährdung für Personen oder der Anlage zu vermeiden: Kapitel "Grundlegende
Sicherheitshinweise" sowie alle anderen, arbeitsspezifischen Sicherheitshinweise im
Dokument sorgfältig lesen.

• Der Hersteller behält sich vor, technische Daten ohne spezielle Ankündigung dem ent-
wicklungstechnischen Fortschritt anzupassen. Über die Aktualität und eventuelle Erwei-
terungen dieser Anleitung gibt Ihre Endress+Hauser Vertriebszentrale Auskunft.
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Versionsverlauf
BA00396G/13.10
• Gültig für Software-Version: 18.0.0
• Erstversion

BA00396G/14.14
• Gültig für Software-Version: 18.0.2 und 18.0.3
• Vorgenommene Änderungen im Vergleich zur vorherigen Version:

Neues Layout; erweiterte Produkt-, Tank- und Verpumpungsfunktionalität; zusätzliche
Funktionen für die Tabellenansicht

BA00396G/15.16
• Gültig für Software-Version: 18.0.2 und 18.0.3
• Vorgenommene Änderungen im Vergleich zur vorherigen Version:

Neue Funktionen

BA00396G/16.17
• Gültig für Software-Version: 18.1.1
• Vorgenommene Änderungen im Vergleich zur vorherigen Version:

Vereinheitlichung der W&M- und Nicht-W&M-Software-Pakete.

BA00396G/17.22
• Gültig für Software-Version: 18.3.2
• Vorgenommene Änderungen im Vergleich zur vorherigen Version:

Rohrvolumen als Teil der Tankvolumina wählbar.

BA00396G/18.24
• Gültig für Software-Version: 18.3.3
• Vorgenommene Änderungen im Vergleich zur vorherigen Version:

Kompatibilität mit Windows 11 und Windows Server 2022. Geringfügige Änderungen
an vorhandener Funktionalität.
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1  Hinweise zum Dokument

1.1  Dokumentfunktion
Dieses Handbuch soll bei der Installation von Tankvision Professional NXA85 unterstüt-
zen.

Es erläutert die grundlegenden Funktionen, die Bediener während des täglichen Betriebs
benutzen.

Abgesehen von grundlegenden Kenntnissen der PC-Bedienung ist keine spezielle Schulung
für die Bedienung des Tankvision Professional Systems erforderlich. Es empfiehlt sich
jedoch, sich von Endress+Hauser zu diesem System schulen zu lassen.

1.2  Software-Versionen und Zertifizierungen
Aufgrund des Zertifizierungsprozesses bei den Eichbehörden kann die neueste Soft-
ware-Version nur in einer späteren Stufe zertifiziert werden. Zudem besteht die Mög-
lichkeit, dass einige Merkmale nicht mit den Vorschriften des eichpflichtigen
Verkehrs kompatibel sind und daher nicht kombiniert werden können.

1.3  Symbole

1.3.1  Warnhinweissymbole
GEFAHR

Dieser Hinweis macht auf eine gefährliche Situation aufmerksam, die, wenn sie nicht ver-
mieden wird, zu Tod oder schwerer Körperverletzung führen wird.

WARNUNG

Dieser Hinweis macht auf eine gefährliche Situation aufmerksam, die, wenn sie nicht ver-
mieden wird, zu Tod oder schwerer Körperverletzung führen kann.

VORSICHT

Dieser Hinweis macht auf eine gefährliche Situation aufmerksam, die, wenn sie nicht ver-
mieden wird, zu leichter oder mittelschwerer Körperverletzung führen kann.

HINWEIS

Dieser Hinweis enthält Informationen zu Vorgehensweisen und weiterführenden Sachver-
halten, die keine Körperverletzung nach sich ziehen.

1.3.2  Symbole für Informationstypen und Grafiken
 Tipp

Kennzeichnet zusätzliche Informationen

Verweis auf Dokumentation

Verweis auf Abbildung

Zu beachtender Hinweis oder einzelner Handlungsschritt

1. , 2. , 3.

Handlungsschritte

Ergebnis eines Handlungsschritts



Hinweise zum Dokument Tankvision Professional NXA85

8 Endress+Hauser

1, 2, 3, ...
Positionsnummern

A, B, C, ...
Ansichten

1.4  Dokumentation
Eine Übersicht zum Umfang der zugehörigen Technischen Dokumentation bieten:
• Device Viewer (www.endress.com/deviceviewer): Seriennummer vom Typenschild

eingeben
• Endress+Hauser Operations App: Seriennummer vom Typenschild eingeben oder

Matrixcode auf dem Typenschild einscannen

1.5  Eingetragene Marken

1.5.1  Microsoft®, Windows®
Microsoft und Windows sind eingetragene Marken der Microsoft Corporation

1.5.2  ModbusTM

Modbus ist eine eingetragene Marke der Schneider Electric USA, Inc.

1.5.3  Java®
Java ist eine eingetragene Marke der Sun Microsystems, Inc.

1.5.4  Mozilla® Firefox®
Mozilla und Firefox sind eingetragene Warenzeichen der Mozilla Foundation

1.5.5  Rechtlicher Hinweis zu Marken
Alle Firmen-Produktnamen und/oder alle Firmenlogos können Handelsbezeichnungen,
Marken und/oder eingetragene Marken von Endress+Hauser, seinen Tochtergesellschaf-
ten oder ihrer jeweiligen Inhaber, mit denen sie verbunden sind, sein.

https://www.endress.com/deviceviewer
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2  Grundlegende Sicherheitshinweise

2.1  Anforderungen an das Personal
Das Personal für Installation, Inbetriebnahme, Diagnose und Wartung muss folgende
Bedingungen erfüllen:
‣ Ausgebildetes Fachpersonal: Verfügt über Qualifikation, die dieser Funktion und Tätig-

keit entspricht.
‣ Vom Anlagenbetreiber autorisiert.
‣ Mit den nationalen Vorschriften vertraut.
‣ Vor Arbeitsbeginn: Anweisungen in Anleitung und Zusatzdokumentation sowie Zertifi-

kate (je nach Anwendung) lesen und verstehen.
‣ Anweisungen und Rahmenbedingungen befolgen.

Das Bedienpersonal muss folgende Bedingungen erfüllen:
‣ Entsprechend den Aufgabenanforderungen vom Anlagenbetreiber eingewiesen und

autorisiert.
‣ Anweisungen in dieser Anleitung befolgen.

2.2  Bestimmungsgemäße Verwendung

2.2.1  Bestimmungsgemäße Verwendung der Tankvision
Professional NXA85 Software

Tankvision Professional wurde spezifisch für Bediener von Großtanklagern, Distributions-
terminals, Raffinerien und Pipelines entwickelt. Es ist darauf ausgelegt, die gesamte
Datenerfassung, Steuerung und Überwachung abzuwickeln, wie sie in einer einzelnen,
vollständig integrierten Lösung erforderlich ist.

Tankvision Professional integriert alle wesentlichen Typen von Tankmessgeräten in ein
System.

Alle gemessenen und berechneten Tankparameter stehen den Tankanlagen- und Termin-
albedienern sowie angeschlossenen Host-Systemen zur Verfügung.

Ein Multi-User-Betrieb wird über den integrierten Webserver bereitgestellt, der die Mög-
lichkeit bietet, über jeden angeschlossenen Standort (lokal/abgesetzt) Daten zu administ-
rativen oder Buchhaltungszwecken abzurufen.

2.3  Produktsicherheit
Dieses Messgerät ist nach dem Stand der Technik und guter Ingenieurspraxis betriebssi-
cher gebaut und geprüft und hat das Werk in sicherheitstechnisch einwandfreiem Zustand
verlassen. Es erfüllt die allgemeinen Sicherheitsanforderungen und gesetzlichen Anforde-
rungen.

2.4  IT-Sicherheit
Eine Gewährleistung unsererseits ist nur gegeben, wenn das Produkt gemäß der Betriebs-
anleitung installiert und eingesetzt wird. Das Produkt verfügt über Sicherheitsmechanis-
men, um es gegen versehentliche Veränderung der Einstellungen zu schützen.

IT-Sicherheitsmaßnahmen gemäß dem Sicherheitsstandard des Betreibers, die das Produkt
und dessen Datentransfer zusätzlich schützen, sind vom Betreiber selbst zu implementie-
ren.
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3  Produktbeschreibung

3.1  Produktidentifizierung
Es gibt folgende Möglichkeiten, die Software zu identifizieren:

• Typenschildangabe
• Bestellcode mit Aufgliederung der Software-Funktionalitäten im Lieferschein
• Seriennummern von Typenschildern in Device Viewer ( www.endress.com/deviceviewer)

eingeben: Alle Angaben zur Software werden angezeigt.

Eine Übersicht zum Umfang der mitgelieferten Technischen Dokumentation: Seriennum-
mer vom Typenschilder in Device Viewer eingeben (www.endress.com/deviceviewer).

3.1.1  Typenschild
Auf dem Typenschild werden die gesetzlich geforderten und produktrelevanten Informati-
onen aufgeführt, zum Beispiel:
• Herstelleridentifizierung
• Produktname
• Bestellcode
• Erweiterter Bestellcode
• Seriennummer
• Barcode

3.1.2  Herstelleradresse

Endress+Hauser SE+Co. KG
Hauptstraße 1
79689 Maulburg, Deutschland
Herstellungsort: Siehe Typenschild.

3.1.3  Bestellcode und Produktversion
Um die Version Ihrer Software zu ermitteln, den auf dem Typenschild angegebenen
Bestellcode in die Suchmaske unter folgender Adresse eingeben:
www.products.endress.com/order-ident
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4  Home Page
Wenn Tankvision Professional über das Start-Menü oder die Verknüpfung auf dem Desk-
top gestartet wird, öffnet sich die Home Page.

Jeder im System konfigurierter Tank wird in einem eigenen grafischen Fenster dargestellt.

Die Startseite verfügt über eine Menüleiste, eine Symbolleiste, einen Anwendungsarbeits-
bereich und eine Statusleiste am unteren Rand des Fensters.

Beim Start des Systems wird die Home Page maximiert angezeigt, und die Fenster aller
Tanks sind geöffnet (siehe Abbildung unten).

 1 Home Page

Die am häufigsten verwendeten Funktionen werden über die Symbolleiste aufgerufen, die
übrigen Funktionen über die Menüs.
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4.1  Mehrere Fenster

 2 Mehrere Home Pages

Die Menüoptionen, mit denen die Funktion zum Anzeigen mehrerer Fenster gesteuert
wird, sind in den Menüs der Home Page zu finden: Window → New Window, Close
Window und Annotate Window.
• New Window – Öffnet ein neues Fenster.
• Close Window – Schließt das aktuelle Fenster (nicht im ‘Master’-Fenster verfügbar).
• Annotate Window – Ändert die Beschriftung des aktuellen Fensters.

Jede Instanz des Fensters Home Page kann mit einem beschreibenden Namen versehen
werden, um es dem Benutzer zu ermöglichen, sie in der Windows-Taskleiste zu identifizie-
ren. Es können unterschiedliche Instanzen der Home Page konfiguriert werden, um unter-
schiedliche Tankgruppen anzuzeigen. Dadurch lassen sich z. B. allgemeine Produkte und
LPG-Produkte in separaten Fenstern anzeigen. Stehen mehrere Monitore zur Verfügung,
können die Home Pages zur besseren Übersicht auf verschiedenen Monitoren angeordnet
werden.

Durch das Schließen der Anwendung werden alle Fenster geschlossen. Durch erneutes Öff-
nen der Anwendung werden alle Fenster an ihren ursprünglichen Positionen wiederherge-
stellt.

4.2  Tank Sicht
Hierbei handelt es sich um die Standardansicht für individuelle Tanks, wenn sie auf der
Home Page angezeigt werden. Siehe Beispiel in der nachfolgenden Abbildung.
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 3 Typisches Tankbild

Das allgemeine Erscheinungsbild und die Größe sind für alle Fenster oder Tankbilder vor-
gegeben. Sie lassen sich jedoch skalieren.

Wenn mehrere Tankbilder geöffnet sind, werden sie in dem auf der Home Page verfügba-
ren Bereich nebeneinander angeordnet angezeigt. Sind mehr Fenster geöffnet als Platz
vorhanden ist, erscheint automatisch am rechten Rand des übergeordneten Fensters eine
Bildlaufleiste.

Die Tankbilder verfügen über eine Reihe von Verknüpfungen zu anderen Anzeigeoptionen
sowie ein kontextsensitives Popup-Menü für den schnellen Zugriff auf weitere Funktionen.

4.3  Basisfenster Tank Sicht
Das Fenster zeigt an:
• Die Nummer des Tanks
• Eine grafische Darstellung des Tanks, die den Tanktyp wiedergibt, z. B. geschlossener

Tank, Schwimmdach etc.
• Das dem Tank zugewiesene Produkt
• Eine Balkenanzeige, die den Füllstand im Tank wiedergibt
• Eine Auswahl an numerischen und Textdatenfeldern, die benutzerkonfigurierbar sind
• Ob aktuell ein Alarm für den Tank aktiv ist
• Wo relevant, ob die numerischen Daten im manuellen oder automatischen Modus sind
• Den Verpumpungsstatus des Tanks, d. h. statisch, Füllung, Entleerung
• Den Verbindungsstatus des Messgeräts, d. h. Verbunden, Unterbrochen, Verbindung

wird aufgebaut, Verbindung wird beendet

Wenn der Verbindungsstatus anders als Verbunden lautet, dann stammen ALLE
Daten dieses Tanks von der letzten Verbindung und sind somit KEINE LIVE-DATEN.

4.3.1  Datenanzeige im manuellen Modus
Alle Datenwerte im manuellen Modus sind durch blauen Text gekennzeichnet.

Das nachfolgend abgebildete Fenster zeigt an, dass sich die Produkttemperatur im manu-
ellen Modus befindet.

Daher werden die Daten mithilfe der Funktion zur manuellen Dateneingabe aktualisiert.
Nähere Informationen hierzu siehe Kapitel zur manuellen Dateneingabe.
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 4 Tankbild mit Temperaturanzeige im manuellen Modus

4.3.2  Manuelle Dateneingabe über eine Verknüpfung aufrufen
Wenn sich ein numerischer Wert, wie hier dargestellt, im manuellen Modus befindet,
kann der Benutzer durch Doppelklick auf den manuellen Wert schnell die Anzeige zur
manuellen Dateneingabe aufrufen. Dadurch wird das Modul zur manuellen Dateneingabe
gestartet.

4.3.3  Verknüpfung zu TAD Stati und Modi
Wenn einer der TAD Werte Tank Mode, Tank Status und Product Status angezeigt wird,
öffnet sich durch Doppelklick auf das Feld ein Dialogfenster, in dem der Tankwert geän-
dert werden kann.

Nähere Informationen hierzu TAD siehe Kapitel "TAD Maintenance".

4.3.4  Schnellzugriffsfunktion auf das Fenster Einzeltank Ansicht
Durch Doppelklick auf das Tankfenster wird die Anzeige Einzeltank Ansicht für den
betreffenden Tank aufgerufen.

Eine vollständige Beschreibung ist im Kapitel zum Modul Einzeltank Ansicht (siehe "Ein-
zeltank Ansicht") zu finden.

Die Anzeige Einzeltank Ansicht kann auch über die Symbolleiste aufgerufen werden.

4.3.5  Tank im Alarmzustand
Wenn für einen Tank ein aktiver Alarm vorliegt, wird der Tank, wie unten dargestellt, mit
dem Symbol eines Signalhorns angezeigt.

 5 Tankbild eines Tanks mit aktivem Alarm

Zusätzlich wird unter dem Signalhorn eine Abkürzung angezeigt, die den Alarmtyp angibt.
Wenn mehrere Alarme aktiv sind, wird der Alarm mit der höchsten Priorität angezeigt. In
dem hier abgebildeten Fall steht LAHH für Level High High Alarm.
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Nähere Informationen hierzu siehe nachfolgende Tabelle.

Alarmcodes

Alarmcode Alarmbeschreibung

LAHH Level Alarm High High (Software)

LAH Level Alarm High (Software)

LAL Level Alarm Low (Software)

LALL Level Alarm Low Low (Software)

HH Level Alarm High High (Messgerät)

H Level Alarm High (Messgerät)

L Level Alarm Low (Messgerät)

LL Level Alarm Low Low (Messgerät)

NO REPLY Keine Antwort vom Messgerät

BAD ALARM Inkongruente Sammlung von Alarmen aktiv
(z. B. High Alarm und Low Alarm gleichzeitig)

GT H Temperatur Hoch (Messgerät)

GT L Temperatur Tief (Messgerät)

PT H Temperatur Hoch (Software)

PT L Temperatur Tief (Software)

GD H Dichte Hoch (Messgerät)

GD L Dichte Tief (Messgerät)

PD H Dichte Hoch (Software)

PD L Dichte Tief (Software)

PD DA Dichte Abweichung (Software)

PT DA Temperatur Abweichung (Software)

PW H Wasser Hoch (Software)

PW L Wasser Tief (Software)

PL VA Variable Alarme

PF HF Fluss Hoch

PF LF Fluss Tief

UMA Unautorisierte Änderungen von Volumen

UMAL Unerlaubte Bewegung (durch Füllstand)

PL FR Schwimmdach Alarm

PL DA Software Differenz Alarm

PU 1...8 UDA: benutzerdefinierter Alarm 1...8

4.3.6  Identifizierung des Alarms nach seinem Eintreten
Beim ersten Auftreten eines Alarms wird ein Ereignis erzeugt. Außerdem erscheint ein
Signalhorn auf dem abgebildeten Tank und die Alarm Event Viewer gibt einen Warnton
oder optional auch eine Sprachnachricht aus.

Nachdem der Alarm quittiert wurde, bleiben als Hinweis auf den Alarm das Signalhorn im
Tankbild und ein entsprechender Eintrag in der Alarm Event Viewer weiterhin bestehen.
Sie werden im Allgemeinen so lange angezeigt, bis die Alarmbedingung behoben wird.
Zusätzlich dazu werden alle aktiven Alarme in der Alarm Übersicht angezeigt.

Für nähere Informationen zu den aktiven Alarmen auf das Signalhorn doppelklicken.

Das Modul Alarm Summary wird geladen. Siehe nachfolgende Abbildung.
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 6 Anzeige Alarm Summary

Das Modul Alarm Summary listet alle aktiven Alarme auf. Bei aktiven Alarmen ist in dem
Kontrollkästchen neben der Alarmbezeichnung ein Häkchen gesetzt.

4.3.7  In Bewegung befindliche Tanks identifizieren

 7 Anzeige von Tanks in Bewegung

Im Fenster Tank Sicht werden in Bewegung befindliche Tanks auf unterschiedliche Art
gekennzeichnet:
• Durch ein Symbol, das die Füllrichtung angibt, d. h. einen Pfeil, der je nach Bewegungs-

richtung nach oben oder unten zeigt (siehe Abbildung oben).
• Durch Größe und Vorzeichen der Durchflussrate, z. B. steht eine positive Durchflussrate

für Füllung und eine negative Durchflussrate für Entleerung.
• Und schließlich kann, sofern entsprechend konfiguriert, die Farbe des im Tank befindli-

chen Produkts den Bewegungsstatus darstellen. So steht Blau z. B. für Füllung, Braun für
Entleerung und Grün für Statisch.

Informationen zur Aktivierung dieser Funktion sind im Handbuch zur Systemkonfigu-
ration, BA00390G (Kapitel "Systemeinstellungen", Kontrollkästchen Use Product
Colour), zu finden.

4.3.8  Verbindungsstatus
Der Verbindungsstatus des Tanks wird auf der rechten Seite angezeigt.

Vier Stati sind möglich:
• Connected
• Disconnecting
• Disconnected
• Connecting
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Der Status Connected bedeutet, dass externe Geräte, z. B. Tankmessgeräte, kontinuierlich
auf Daten abgefragt werden. Bei Modemverbindungen werden die Daten möglicherweise
nur periodisch abgefragt.

Wenn der Verbindungsstatus anders als Connected lautet, dann stammen ALLE Daten
dieses Tanks vom Zeitpunkt der letzten Verbindung und sind somit KEINE LIVE-DATEN.

 8 Tank im Zustand Unterbrochen

Im der Abbildung oben hat der Tank den Status Disconnected und zeigt den Diagnosecode
DN00 an, was bedeutet, dass er keine Antwort vom Messgerät erhält.

4.4  Optionen im Kontextmenü
Es steht ein Kontextmenü zur Verfügung. Wenn der Benutzer mit der Maustaste auf ein
beliebiges Tank Sicht-Fenster klickt, erscheint ein Popup-Menü (siehe Abbildung unten).

 9 Aufgerufenes Kontextmenü

Einige der Optionen in diesem Popup-Menü hängen von der Konfiguration des jeweiligen
Tanks ab. Sie werden im Folgenden in diesem Kapitel erläutert.

4.4.1  Produkt
Die Menüoption Product enthält ein Untermenü, in dem die Produkte in der Reihenfolge
ihrer Verwendung sortiert sind (das Produkt, das den meisten Tanks zugeordnet ist, steht
an erster Stelle). Diese Option wird verwendet, um das einem Tank zugeordnete Produkt
zu ändern. Das aktuell zugeordnete Produkt wird durch ein Häkchen neben dem Produkt-
namen gekennzeichnet und ausgegraut dargestellt. Wenn aktuell mehr als zwölf Produkte
zu Tanks zugeordnet sind, kann über den letzten Menüpunkt die Anzeige Produkt Aus-
wahl geöffnet werden:
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 10 Anzeige Produkt Auswahl

Auf den Pfeil klicken, um ein Product auszuwählen. Dadurch öffnet sich eine Liste aller
Produkte (wieder in der Reihenfolge ihrer Verwendung sortiert). Alternativ kann der
Name des gewünschten Produkts eingegeben werden. Während der Eingabe des Produkt-
namens erscheint eine verkürzte Liste mit Produkten, deren Bezeichnungen mit dem ein-
gegebenen Text übereinstimmen:

 11 Filtern der Produktauswahl nach Name

4.4.2  Manuelle Daten
Die Menüoption Manueller Modus bietet ein Untermenü, das alle im manuellen Modus
verfügbaren Optionen enthält. Mithilfe dieser Option können die Werte zwischen dem
manuellem und dem automatischem Modus umgeschaltet werden.

Alle im manuellen Modus befindlichen Werte sind durch ein Häkchen gekennzeichnet.

4.4.3  Alarm aktivieren
Wenn diese Menüoption angezeigt wird, führt sie zu einem Untermenü, das angibt, ob ein
Alarm aktiviert oder deaktiviert ist. Ein Häkchen neben der Menüoption gibt an, dass der
Alarm für dieses Datenelement aktiviert ist.

4.4.4  Bewegungen
Wenn diese Menüoption angezeigt wird und aktiviert ist, steht dem Benutzer eine komfor-
table Möglichkeit zur Verfügung, um die Produktverpumpungen für einen Tank aufzuru-
fen. Durch Auswahl einer im Untermenü aufgeführten Bewegung werden die Details zu
dieser Bewegung angezeigt.

4.4.5  Geräte Befehle
Die Menüoption Device Commands bietet ein Untermenü, das alle in diesem Kontext ver-
fügbaren Gerätebefehle enthält.
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 12 Gerätebefehle zum Tankbild

Im Folgenden werden die einzelnen Befehle näher erläutert.

Servo Check
Führt eine Wiederholpräzisionsprüfung auf einem servobasierten Messgerät durch. Dieser
Befehl versucht, den Verdränger um mindestens 300 mm anzuheben und dann wieder auf
der Flüssigkeitsoberfläche abzusetzen. Der Füllstand vor dem Anheben des Sensors wird
mit dem Füllstand verglichen, nachdem der Sensor auf die Flüssigkeitsoberfläche zurück-
gekehrt ist. Liegen beide Füllstände innerhalb der definierten Toleranz, gilt der Servo Test
als bestanden. Wenn dieser Befehl erteilt wird, wird ein Ereignis generiert.
Dieser Befehl ist nur für servobasierte Messgeräte verfügbar.

Stow
Fährt den Sensor des Messgeräts bis an die gesperrte oder oberste Stopp-Position. Dieser
Befehl ist nur für servobasierte Messgeräte verfügbar.

Unstow
Bricht den Befehl Stow ab und fährt den Sensor zur Position auf der Flüssigkeitsoberfläche
zurück. Kann auch dazu verwendet werden, jeden anderen Befehl abzubrechen, der gerade
ausgeführt wird.

Freeze
Hält den Verdränger an seiner aktuellen Position.

Unfreeze
Hebt den letzten Freeze-Befehl auf und erlaubt dem Verdränger, zur Position auf der Flüs-
sigkeitsoberfläche zurückzufahren.

Water Scan
Durch Auswählen dieser Option versucht das Messgerät, die Wassertrennschicht zu finden
und die Flüssigkeitsoberfläche auszugeben. Beachten, dass dieser Befehl nur funktioniert,
wenn das Messgerät die Funktion Wasser Scan unterstützt.

Density Scan
Durch Auswählen dieser Option fragt das Messgerät das Dichteprofil ab und gibt die
durchschnittliche gemessene Dichte aus. Beachten, dass dieser Befehl nur funktioniert,
wenn das Messgerät Dichteprofile unterstützt.
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Alarm Test
Durch Auswählen dieser Option wird die Verdrängerposition bis zum Tankdach angeho-
ben, wodurch alle aktivierten Alarme ausgegeben werden.
HINWEIS: Je nach Messgerätetyp können die Befehle einen Alarm erzeugen. Ebenso kann
es während der Ausführung von Befehlen zu Statusänderungen kommen.

Abfrage Modus
Off Scan, Normal Scan und Fast Scan sind sich gegenseitig ausschließende Optionen, mit
deren Hilfe der Benutzer steuert, wie häufig das Messgerät abgefragt wird.
• Off Scan

Das Messgerät wird nicht abgefragt.
• Normal Scan

Das Messgerät wird in den normalen Intervallen abgefragt.
• Fast Scan

Das Messgerät wird bei jeder zweiten Abfrage (d. h. häufiger) abgefragt, und zwar zu
Lasten anderer Messgeräte.

• Manual Scan
Wird verwendet, wenn für das Messgerät Off Scan eingestellt wurde, damit das Gerät
einmalig abgefragt wird.

Verbindungsstatus
Connect, Disconnect, Connect Once sind sich gegenseitig ausschließende Optionen, die
den Verbindungsstatus des Schnittstellenports festlegen, an den der Tank angeschlossen
ist. Wenn einer dieser Befehle an einen Tank gesendet wird, gilt er daher für ALLE Tanks,
die an denselben COM-Port oder dasselbe Modem auf dem PC angeschlossen sind.
• Connect

Die Schnittstelle stellt eine Verbindung zum COM-Port oder Modem her und fragt die
Messgeräte unbegrenzt auf Daten ab oder bis vom Benutzer der Befehl Unterbrochen
ausgegeben wird.

• Disconnect
Die Schnittstelle unterbricht die Verbindung zum COM-Port oder Modem und bleibt
getrennt. Die Daten der letzten Aktualisierung werden angezeigt.

• Connect Once
Die Schnittstelle stellt eine Verbindung zum COM-Port oder Modem her und trennt die
Verbindung automatisch, sobald sie alle Daten bei den Messgeräten abgerufen hat. Die
über die Verbindung abgefragten Daten werden angezeigt.

Wenn der Befehl Disconnect ausgewählt wird, öffnet sich ein Dialogfenster, in dem dieser
Befehl bestätigt werden muss, da durch diesen Befehl die Aktualisierung ALLER an dersel-
ben Schnittstelle angeschlossenen Messgeräte gestoppt wird. Beachten, dass die Ausgabe
eines Befehls an einen Tank sich auch auf alle übrigen Tanks auswirkt, die mit derselben
Schnittstelle verbunden sind. Daher sind diese Befehle mit Vorsicht zu verwenden, da sie
zum Verlust von Daten für kritische Tanks führen können.

4.5  Verwendung der Funktionstasten
Die Funktionstasten können benutzerspezifisch angepasst werden, sodass sie als Verknüp-
fungen zu anderen auf dem Computer installierten Funktionen und Merkmalen dienen,
die sich dadurch mit nur einem Tastendruck aufrufen lassen. Zunächst muss für die
gewünschte Funktionstaste eine exe-Datei erstellt werden, in diesem Beispiel für die
Tabellenansicht.

Nach der Datei FunctionKey.ini im Ordner der Anwendung suchen
(C:\Program Files\Endress+Hauser\Tankvision Professional\).

Dann die Datei bearbeiten.

text= Den Text für die Menüoption eingeben, in diesem Fall F2 GridView.
exe= Pfadname für die exe-Datei. Die Dateierweiterung .exe am Ende nicht vergessen.
Icon= Pfadname für das Symbol. Die Dateierweiterung .ico am Ende nicht vergessen.
hide= 0 verwenden, damit die Option im Funktionstastenmenü erscheint.
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Beispiel: Taste F2 startet die Tabellenansicht.
[F2]
text = GridView
exe = GridView.exe
icon = myicons\myicon.ico
hide = 0
Home Page stoppen und neu starten, um die Funktionalität zu initialisieren.
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5  Einzeltank Ansicht
In der Anzeige Einzeltank Ansicht sind alle Daten zu einem einzelnen Tank detailliert auf-
geführt.

Sie kann wie folgt gestartet werden:
• Durch Doppelklick auf das Fenster Tank Sicht
• Durch Klick auf die Schaltfläche Einzeltank Ansicht in der Symbolleiste

Nachdem das Modul Single Tank Overview geladen wurde, können weitere Tanks ange-
zeigt werden. Hierzu die gewünschten Tanks in der Dropdown-Liste auswählen.

Die angezeigten Daten sind nach logischen Gruppen organisiert: primäre Messwerte,
Durchflussraten, Bestandsdaten und Alarmeinstellungen.

Im manuellen Modus befindliche Datenwerte sind durch blauen Text gekennzeichnet.

Datenwerte, die aus irgendeinem Grund nicht zur Verfügung stehen, werden durch eine
Diagnosenummer ersetzt.

Die Abbildung unten zeigt ein typisches Beispiel.

 13 Typische Anzeige Einzeltank Ansicht

Im gesamten Modul werden Quickinfos verwendet, um dem Benutzer zu jedem der ange-
zeigten Datenfelder nähere Informationen zu liefern.

5.1  Tank im Alarmzustand
Wenn für den ausgewählten Tank ein Alarm aktiv ist, wird der Tank mit einem Signalhorn
dargestellt. Durch Doppelklick auf das Signalhorn wird die Anzeige Alarm Summary
geöffnet, die Details dazu enthält, welche Alarme aktiv sind.

Alle aktuell aktiven Alarme sind in der Anzeige Alarm Summary durch ein Häkchen
gekennzeichnet. Siehe Abbildung unten.
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 14 Anzeige Alarm Summary mit aktiven Alarmen High und High High

5.2  Elementtemperaturen anzeigen
Einige Tankmessgeräte sind in der Lage, mehrere Temperaturpunkte von speziellen Tem-
peraturmessgeräten zu messen. Sie werden allgemein als Durchschnittstemperaturther-
mometer, Multispot-Temperatursonden etc. bezeichnet.

Temperaturprofile können nur in folgenden Fällen angezeigt werden
• Das System wurde dafür konfiguriert, Elementtemperaturen abzufragen. Hierfür

muss der Benutzer sicherstellen, dass in der Anzeige Geräte Konfiguration neben
dem betreffenden Messgerät der Merker Average Temp. Fitted ausgewählt ist
(Häkchen gesetzt).

• Das Teilsystem zur Trenderstellung ist dafür konfiguriert, für dieses Messgerät
Trends zu den Temperaturelementen zu erstellen. Dies geschieht über die Anzeige
Trend Konfiguration.

Nähere Informationen zu den oben aufgeführten Optionen siehe Konfigurationshand-
buch.

Um die Anzeige Temperatur Profile zu öffnen, auf die entsprechende Schaltfläche in der
Übersichtsanzeige klicken.

Mit der rechten Maustaste klicken, um einen Tank zur Anzeige hinzuzufügen, siehe unten.
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 15 Typische Ansicht der Elementtemperaturen

Über die Registerkarte Graph können die Daten in grafischer Form dargestellt werden. In
dieser Anzeige werden zudem zusätzliche Details des Profils aufgeführt, wie z. B. der
Durchschnittswert etc.

Die grafische Anzeige kann mithilfe der folgenden Menüoptionen konfiguriert werden:
• View → Average Temperature

Diese Option auswählen, um die Durchschnittstemperatur anzuzeigen.
• View → Data Points

Diese Option auswählen, um die einzelnen Datenpunkte in der Grafik anzuzeigen.
• View → Data Labels

Dieses Element auswählen, um die individuellen Datenwerte in der Grafik anzuzeigen.
• Tools → Options

Öffnet ein Dialogfenster, in dem die Farben konfiguriert werden können, die für die ver-
schiedenen Linien in der Grafik verwendet werden sollen.

• Tools → Configure Element Levels
Öffnet ein Dialogfenster, in dem die Höhen für die Temperaturelemente eingegeben
werden können. Sie werden dann anstelle der Elementnummern verwendet, um die Gra-
fik zu erstellen.

Standardmäßig wird die Temperatur in der Grafik mithilfe der Mindest- und Höchstwerte
aus der Tabelle skaliert. Dies kann manchmal jedoch zu einer irreführenden Anzeige füh-
ren. Der Bereich kann manuell eingestellt werden. Hierzu die Option Enable Temperature
Min/Max auswählen und dann den Mindest- und Höchstwert für den Bereich eingeben.

Die Grafik kann als Bitmap gespeichert werden. Hierzu folgende Option auswählen File →
Save Graph ...
Durch Klicken auf die Registerkarte Data können die Daten auch im Tabellenformat ange-
zeigt werden, .
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 16 Tabellenansicht der Elementtemperaturen

5.3  Profildaten anzeigen
Einige Tankmessgeräte sind in der Lage, ein Dichte-/Temperaturprofil (oder bei einigen
Tankmessgeräten auch nur die Dichte) für das gesamte im Tank enthaltene Produkt zu
erstellen.

Diese Daten können danach als Tabelle mit Dichte- und Temperaturwerten (sofern unter-
stützt) ausgegeben und in der Datenbank gespeichert werden.

Danach lassen sich die Profildaten in grafischer oder tabellarischer Form anzeigen.

Einzelne Profilansicht
Es kann immer nur ein Profil angezeigt werden.

Die Anzeigen werden über das Fenster Single Tank Overview geöffnet.
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6  Anmeldung

6.1  Sicherheit
Der Zugriff auf die Systemfunktionen kann über Benutzerkonten gesteuert werden. Die
Anforderung, sich beim System anzumelden, kann auch deaktiviert werden, sodass jeder
Benutzer umfassenden Zugriff auf das System hat. Wenn die Sicherheitsfunktion aktiviert
ist, gelten die folgenden Kapitel.

6.2  Anmelden
1.

 17 Menü Sicherheit auf der Home Page

Im Hauptmenü die Option Security → Log In... auswählen und zwar entweder auf der
Home Page (siehe oben) oder in der Alarm Event Viewer. Andere Möglichkeiten zur
Anmeldung sind die Sicherheitsmanager-Schaltfläche in der Windows-Taskleiste
oder die automatische Anmeldung, wenn ein Benutzer versucht, auf eine System-
funktion zuzugreifen, für die eine entsprechende Berechtigung erforderlich ist.
 Es öffnet sich ein Dialogfenster, in dem sich der Benutzer anmelden kann.

 18 Dialogfenster Anmelden

2. Den erforderlichen Benutzernamen und das Passwort eingeben.
 Die Eingaben werden mit den Einträgen in der Datenbank verglichen. Wenn der

Benutzername und das Passwort gültig sind, wird der Benutzer mit der ihm zuge-
wiesenen Zugangsstufe angemeldet.

Jedes Benutzerkonto verfügt für den Zugriff auf die einzelnen Funktionen über eine
bestimmte Zugangsstufe. Das bedeutet, dass ein Benutzer, selbst wenn er angemeldet
ist, nicht automatisch Zugriff auf alle Funktionen hat. Die Zugangsstufen der Benutzer
ergeben sich aus den Berechtigungen, die ihnen der Systemadministrator zugewiesen
hat.

Wenn ein Benutzer beim System angemeldet ist, wird der Benutzername auf der Home
Page und in der Alarm Event Viewer in der Statuszeile im Feld ganz links außen ange-
zeigt, wie in der Abbildung unten dargestellt ist.
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 19 Statuszeile der Home Page mit dem Namen des angemeldeten Benutzers

6.3  Abmeldung
Im Hauptmenü die Option Security → Log Out auswählen.

Das System meldet den aktuell angemeldeten Benutzer sofort ab. Dadurch wird der Zugriff
auf alle Funktionen verhindert, die eine Anmeldung erfordern.

6.4  Neue Benutzerkonten konfigurieren
Nähere Informationen hierzu sind im Handbuch für Systemadministratoren im Kapitel zur
Konfiguration der Sicherheit zu finden.

Es sollte insbesondere auf die Zugriffsrechte für neue Benutzer geachtet werden.
Nicht alle Benutzer sollten die höchste Zugriffsstufe erhalten. Der Systemadministra-
tor sollte dafür verantwortlich sein, die Berechtigungen für die einzelnen Benutzer
festzulegen.

Es empfiehlt sich, Benutzern, die das System nur gelegentlich verwenden, zu Anfang
nur die niedrigste Zugriffsstufe zu erteilen. Die Berechtigungen können später in dem
Maße angepasst werden, in dem die Benutzer mit der Bedienung des Systems vertraut
werden.
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7  Alarme und Ereignisse

7.1  Einführung
An vielen Standorten werden die Begriffe Alarme und Ereignisse oftmals verwechselt.
Daher lohnt es sich, diese Begriffe im Kontext dieses Tankmesssystems genauer zu erläu-
tern.

Einfach ausgedrückt führen Alarme zu einem Ereignis.

Zur Erläuterung soll hier ein High Level Alarm verwendet werden: Es kann ein Grenzwert
definiert werden, bei dessen Erreichen der Alarm aktiv wird (das impliziert gleichzeitig,
dass es einen Punkt gibt, an dem der Alarm inaktiv wird). Wenn der Alarm aktiv wird,
wird ein Ereignis aufgezeichnet, das die Bediener auf den Alarm aufmerksam macht. Nicht
alle im System aufgezeichneten Ereignisse sind das Ergebnis eines Alarms. So ist beispiels-
weise ein Fehler in der Kommunikation mit den Feldinstrumenten ein bedeutendes Ereig-
nis, allerdings steht kein Alarm dahinter.

7.2  Verhalten bei Auftreten eines Alarms
Wie unten dargestellt, erscheint im Fenster Tank Sicht auf dem abgebildeten Tank das
Symbol eines Signalhorns.

 20 Tankbild eines Tanks mit aktivem Alarm

Die Beschreibung des Alarmzustands in der Grid View und in der Single Tank Overview
ändert sich, um den Alarm mit der höchsten Priorität anzuzeigen. Für eine Erläuterung der
abgekürzten Codes siehe Tabelle "Alarmcodes".

System generiert ein Ereignis und zeigt es im Fenster Alarm Event Viewer an.
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 21 Alarm Event Viewer

Sofern entsprechend aktiviert, wird außerdem ein Warnton ausgegeben. Hierbei kann es
sich, abhängig von den Optionen, mit denen das System ausgestattet ist, um einen inter-
nen Summer, eine Soundkarte oder eine externe Hupe handeln. Über die Soundkarte des
PCs kann zudem eine Sprachnachricht abgespielt werden, sofern diese Funktion aktiviert
ist.

Sobald ein Alarm quittiert wurde, wird der Warnton ausgeschaltet. Wenn die Sicherheits-
funktion aktiviert ist, muss sich der Benutzer mit den korrekten Berechtigungen anmel-
den, um den Alarm quittieren zu können.

Alle Alarme und Ereignisse werden in der Datenbank protokolliert. Der Benutzer kann
eine Alarmhistorie aufrufen, um sich alle bisher aufgetretenen Alarme und Ereignisse
anzusehen.

Wenn ein Alarm quittiert wird, werden Datum und Uhrzeit in der Datenbank protokolliert.
Ebenso wird der Name des angemeldeten Benutzers aufgezeichnet, der den Alarm quit-
tiert.

7.3  Alarme quittieren
Die Alarm Event Viewer zeigt, wie unten dargestellt, Details zu den Alarmen an:

 22 Alarm Event Viewer
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Der Status des jeweiligen Alarms wird in den Spalten ganz links und ganz rechts angege-
ben:
• Rot

Nicht quittiert und Warnton nicht ausgeschaltet. Blinkt bei einem "aktiven" Alarm.
• Hellblau

Warnton ausgeschaltet, aber nicht quittiert.
• Grün

Quittiert.

Um den Warnton eines Alarms auszuschalten (Alarm stummschalten) oder einen Alarm
zu quittieren, muss der Alarm zuerst ausgewählt werden, indem mit der Maus auf die
betreffende Zeile geklickt wird. Nachdem der Alarm ausgewählt wurde (die Hintergrund-
farbe wechselt zu Blau), kann der Alarm stummgeschaltet oder quittiert werden. Wenn die
Sicherheit aktiviert ist, muss der Benutzer beim System angemeldet sein, um einen Alarm
stummschalten oder quittieren zu können.

Der ausgewählte Alarm kann durch Klicken auf die Schaltfläche Alarm quittieren ( )
oder über ein Tastaturkürzel quittiert werden.

Siehe Handbuch zur Systemkonfiguration, BA00390G, Kapitel zu den Optionen für
Benachrichtigungen.

Wenn der ausgewählte Alarm so konfiguriert wurde, dass für die Quittierung die Angabe
eines Grunds erforderlich ist, dann öffnet sich die Anzeige Acknowledgement Reason:

 23 Eingabe eines Quittiergrunds

Die Schaltfläche OK steht erst dann zur Verfügung, nachdem ein Grund eingegeben wurde.
Der Alarm kann nur durch Klicken auf OK quittiert werden.

7.3.1  Alarm stummschalten
Der ausgewählte Alarm kann durch Klicken auf die Schaltfläche Hupe aus ( ) oder über
ein Tastaturkürzel stummgeschaltet werden.

Siehe Handbuch zur Systemkonfiguration, BA00390G, Kapitel zu den Optionen für
Benachrichtigungen.

7.3.2  Mehrere Alarme quittieren oder stummschalten
Es besteht die Möglichkeit, einzelne oder mehrere Alarme auf einmal zu quittieren oder
stummzuschalten, indem mit der rechten Maustaste auf die Alarmliste geklickt wird.
Dadurch öffnet sich ein Menü mit verschiedenen Optionen:
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 24 Kontextmenü für Alarm Event Viewer

Es ist nicht möglich, mehrere Alarme gleichzeitig zu quittieren, wenn einer oder meh-
rere der ausgewählten Alarme die Eingabe eines Quittiergrunds erfordern.

Alarme, die eine Begründung erfordern, sollten zuerst individuell quittiert werden.

7.4  Anzeige Ereignis Verlauf
Die Anzeige Ereignis Verlauf kann entweder durch Klicken auf die entsprechende Schalt-
fläche in der Symbolleiste auf der Home Page oder durch Auswählen der Option View →
Events im Menü der Alarm Event Viewer gestartet werden.

 25 Ereignis Verlauf

Standardmäßig werden alle Ereignisse des aktuellen Tages angezeigt. Die Ereignisse kön-
nen nach Datum, Programmteil, Quittierdatum und Benutzer gefiltert werden. Für Clients,
die an mehrere Server angeschlossen sind, kann sogar angegeben werden, von welchem
Server die Ereignisse abgerufen werden sollen. Diese Einstellungen werden gespeichert,
sobald die Anzeige Ereignis Verlauf geschlossen wird, und werden beim nächsten Start der
Anzeige Ereignis Verlauf als Vorgaben verwendet.

Die Ereignisanzeige zeigt auch Details zu auditierbaren Maßnahmen an. Der Benutzer
kann mithilfe der Schaltflächen  und  filtern, ob Ereignisse und/oder auditierte Maß-
nahmen angezeigt werden sollen. Durch Doppelklick auf eine auditierte Maßnahme kön-
nen weitere Details zu dieser Maßnahme angezeigt werden. Dadurch öffnet sich eine
Anzeige, in der die Änderungen detailliert aufgeführt sind:
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 26 Detaillierte Audit-Aufzeichnung im Ereignis Verlauf
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8  Reporte
Es steht ein Standardset von Reporten zu Tankstandmessung und zum Lagerbestand zur
Verfügung.

Wie folgt vorgehen, um auf die Reporte zuzugreifen:

1. Im Hauptmenü der Home Page die Option File → Reports auswählen.


 27 Anzeige Report wählen

2. Den gewünschten Report auswählen (erster Schritt im Wizard).

Group Selection
Ein Report für eine benutzerdefinierte Gruppe von Tanks.

Product Selection
Ein Report mit einer Zusammenfassung aller Tanks, die ein bestimmtes Produkt enthalten
(z. B. Jet A1).

Standard Inventory Report
Zeigt eine Standardauswahl an Bestandsdaten für alle Tanks an.

Standard Summary Report
Fasst die Lagerbestände für alle Tanks nach Produkt zusammen.

Gauge Configuration
Ein Report, der die Hauptkonfigurationsdaten des Messgeräts enthält.

Tank Configuration
Ein Report, der die Hauptkonfigurationsdaten des Tanks enthält.

Custom Print
Ermöglicht es, einen von einem Dritten erstellten Report auszuwählen und vom Tank-
messsystem ausführen zu lassen. Der Benutzer kann im Reportbaum unter dem Eintrag
Custom eine RPT-Datei auswählen.

3. Wenn der Benutzer einen Report ausgewählt hat, der die Eingabe weiterer Parame-
ter, wie z. B. ein Produkt oder eine statische Gruppe, erfordert, dann kann er im
nächsten Schritt des Wizards die relevanten Parameter auswählen. Wenn der ausge-
wählte Report keine weiteren Parameter erfordert, wird dieser Schritt ausgelassen.

4. Zuletzt Drucken oder Vorschau wählen, um eine Hardcopy des Reports zu erstellen
oder eine Vorschau des Reports im Bildschirm anzuzeigen. Wenn der Benutzer Dru-
cken auswählt, wird der Report an den Standarddrucker gesendet, der in Windows
konfiguriert ist. Wählt der Benutzer Vorschau und dann Drucken, hat er die Möglich-
keit, den Drucker auszuwählen, der verwendet werden soll.
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9  Tabellenansicht
Bei der Tabellenansicht handelt es sich um eine tabellarische Darstellung der Tankdaten.

Die Anwendung Tabellenansicht kann benutzerspezifisch angepasst werden und umfasst
ein Kontextmenü mit den üblichen Gerätebefehlen.

Benutzer können eigene Datenansichten erstellen und sie mit den Standardfunktionen zur
Tankgruppierung kombinieren, um die Datendarstellung vollständig benutzerspezifisch
anzupassen.

Die Tabellenansicht wird durch Klicken auf die entsprechende Schaltfläche in der Symbol-
leiste gestartet.

9.1  Tabellenansicht starten
In der Symbolleiste auf die Schaltfläche Grid View klicken oder alternativ die Anwendung
GridView.exe im Zielordner ausführen. Die nachfolgende Abbildung zeigt eine typische
Tabellenansicht.

 28 Grid View

Im Fenster Tabellen Ansicht befinden sich im Menü File zwei Optionen: New Window und
Close Window.

New Window öffnet ein neues Fenster, und Close Window schließt das aktuelle Fenster
(nicht im "Master"-Fenster verfügbar). Die neue Instanz kann dafür konfiguriert werden,
dass sie eine andere Tankgruppe anzeigt als die erste. Wenn mehrere Monitore zur Verfü-
gung stehen, können die Fenster zur besseren Übersicht auf verschiedenen Monitoren
angeordnet werden.

9.2  Datenansichten auswählen
Die Grid View verfügt standardmäßig über mehrere vordefinierte Datenansichten. Die ver-
fügbaren Datenansichten sind in der Dropdown-Liste in der Symbolleiste aufgeführt. Siehe
nachfolgende Abbildung für weitere Informationen.
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 29 Auswählen einer Ansicht in der Grid View

Die fest vorgegebenen Views sind:
• Tank Gauging
• Tank Inventory
• Gauge Status
• Movements
Jede dieser Ansichten enthält verschiedene Spalten mit Informationen. Alle übrigen aufge-
listeten Ansichten sind benutzerdefinierte Ansichten. Der Benutzer kann weitere Ansich-
ten konfigurieren.

9.3  Tankgruppen auswählen
Standardmäßig zeigt das Modul Grid View alle Tanks an.

Der Benutzer kann eine der vorkonfigurierten Tankgruppen auswählen, um nur die Tanks
anzuzeigen, die in dieser Gruppe enthalten sind.

Die verfügbaren Gruppen sind in der Dropdown-Liste in der Symbolleiste aufgeführt.

Die nachfolgende Abbildung zeigt ein Beispiel.

 30 Eine Gruppe in der Grid View auswählen

Wenn keine Gruppen konfiguriert wurden, ist die Liste bis auf die fest vorgegebene Gruppe
All Tanks leer.

9.4  Spezifische Tanks suchen
Die Grid View ermöglicht es dem Benutzer, in der Tankliste nach spezifischen Tanks zu
suchen. Wenn die ID des Tanks bekannt ist, kann sie direkt in das dafür vorgesehene Feld
eingegeben werden. Die Tabellenansicht blättert dann nach oben oder unten bis zu der
Zeile, in der der gewünschte Tank gefunden wurde. Alternativ kann der Tank in der Drop-
down-Liste ausgewählt werden. Die Tabellenansicht blättert dann ebenfalls nach oben
oder unten, um den ausgewählten Tank anzuzeigen.
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9.5  Tanks mit Alarm
In der Symbolleiste steht eine Reihe von Schaltflächen zur Verfügung, über die sich schnell
alle Tanks übersichtsartig anzeigen lassen, für die ein Messgerätealarm aktiv ist.

 31 Symbolleiste in der Grid View zum Filtern von Alarmzuständen

9.6  Neue Datenansicht konfigurieren
Benutzer können eine eigene benutzerspezifische Ansicht der Tankanlagendaten erstellen,
die sich für die von ihnen durchgeführten Vorgänge optimal eignet. Diese benutzerspezifi-
sche Ansicht erscheint zusammen mit den vordefinierten Ansichten in der Liste der
Ansichten (siehe "Datenansichten auswählen").

1. Zum Definieren einer neuen Ansicht Options → Maintain Views... im Menü der Grid
View auswählen.
 Die Anzeige Maintain Views wird wie unten dargestellt geöffnet.

 32 Ansichten anpassen
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2. Auf New klicken. Es öffnet sich ein Fenster, in dem der Benutzer den Namen der
Ansicht definieren und die Datenspalten auswählen kann, die angezeigt werden sol-
len.


 33 Eine Ansicht in der Tabellenansicht definieren

Bitte beachten: Dieselben Optionen dienen auch dazu, die Ansichten zu bearbei-
ten, nachdem sie definiert wurden.

Bei einer neuen Ansicht ist das Feld View Name leer und muss ausgefüllt werden, bevor
die Ansicht gespeichert werden kann.

Die Liste auf der linken Seite enthält die Felder, die zur Ansicht hinzugefügt werden kön-
nen.

Diese Liste kann sortiert werden:
• nach Typ 
• alphabetisch 
• unsortiert 

3. Um ein Feld zu einer Ansicht hinzuzufügen, entweder das Feld auswählen und auf
die Schaltfläche für Hinzufügen ( ) klicken oder auf das Feld doppelklicken. Um alle
Felder eines bestimmten Typs zur Ansicht hinzuzufügen, ein beliebiges Feld im Typ
auswählen und auf die Schaltfläche für Alle hinzufügen ( ) klicken.

Die Liste auf der rechten Seite enthält die Felder, die aktuell in der Ansicht enthalten sind.

4. Um ein Feld aus der Ansicht zu entfernen, entweder das Feld auswählen und auf die
Schaltfläche für Entfernen ( ) klicken oder auf das Feld doppelklicken. Um alle Fel-
der aus der Ansicht zu entfernen, auf die Schaltfläche für Alle entfernen ( ) klicken.

5. Um die Änderungen zu speichern und das Fenster zu verlassen, auf OK klicken. Um
das Fenster zu verlassen, ohne die an der Ansicht vorgenommenen Änderungen zu
speichern, auf Cancel klicken.

6. Um eine Ansicht zu löschen, die Ansicht markieren und auf Delete klicken.
 Die ausgewählte Ansicht wird gelöscht.

7. Um das Fenster Ansichten anpassen zu verlassen, auf Close klicken.

9.7  Farbe der Durchflussdarstellung
Wenn die Ansicht eine Spalte für die Durchflussrate enthält, dann werden Zeilen mit
Tanks in Bewegung entweder in Braun oder Blau dargestellt. Braun hinterlegte Zeilen
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geben an, dass der Füllstand im Tank sinkt, blau hinterlegte Zeilen geben an, dass der Füll-
stand steigt. Statische Tanks werden in der normalen Hintergrundfarbe angezeigt.

 34 Farben für Durchflussraten, die Tanks mit steigendem und sinkendem Füllstand kennzeichnen

Die Tabelle bietet drei benutzerkonfigurierbare Schwellwerte, um festzulegen, wann eine
Zeile farbig dargestellt werden soll. Die Schwellwerte werden abhängig davon verwendet,
ob die Ansicht eine Durchflussrate für Füllstand, Masse oder Volumen anzeigt.

Um die Schwellwerte zu konfigurieren, im Menü Options → Set Flow Rate Colour Thres-
holds... auswählen. Das Dialogfenster Flow Rate Threshold wird angezeigt.

 35 Dialogfenster zur Konfiguration der Schwellwerte für die Durchflussrate

9.8  Kontextabhängige Funktionen
Ähnlich wie auf der Home Page können auch in der Tabellenansicht Messgerätebefehle
ausgegeben und andere Funktionen ausgewählt werden. In den meisten Fällen wird durch
einen Rechtsklick auf einen spezifischen Tank in der Tabellenansicht ein Kontextmenü
geöffnet, in dem diese Funktionen ausgewählt werden können.

9.8.1  Messgerätebefehle
Durch Rechtsklick auf einen bestimmten Tank wird ein Kontextmenü mit Messgerätebe-
fehlen geöffnet. Bitte beachten: Ist ein Tank mit mehreren Messgeräten ausgestattet, wird
der Befehl an das primäre Messgerät gesendet.
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9.8.2  Einfache Bewegungen
In dieser Ansicht gibt es verschiedene Optionen zum Einrichten und Stoppen von Verpum-
pungen. Das Aktivieren einer Verpumpung beinhaltet die Berechnung des Zielfüllstands
für die Verpumpung und die Konfiguration von Alarmwerten, um den Vorgang abzuwi-
ckeln. Das Stoppen einer Verpumpung deaktiviert die Alarme, sobald der Verpumpungs-
vorgang abgeschlossen wurde. Nähere Informationen hierzu siehe Handbuch Einfache
Bewegungen, BA01653G.

Dies gilt NICHT für vollständige Bewegungen.

9.8.3  Einzeltank Ansicht
In den meisten Fällen führt ein Doppelklick in einer Spalte dazu, dass das Fenster Single
Tank Overview geöffnet wird (siehe Kapitel "Einzeltank Ansicht") und den Tank der ausge-
wählten Zeile anzeigt.

9.8.4  TAD
Durch Doppelklick auf eine Spalte, die TAD-Daten enthält, kann der Bediener diese Ein-
stellung ändern. Nähere Information zu TAD siehe Kapitel "TAD Maintenance".

9.9  Drucken und Druckvorschau
Der aktuelle Inhalt der Grid View kann an einen Drucker ausgegeben oder im Bildschirm
in einer Vorschau angezeigt werden.

9.9.1  Tabellenansicht drucken
Um den aktuellen Inhalt der Grid View zu drucken, entweder File → Print im Menü aus-
wählen, oder in der Symbolleiste auf die Schaltfläche zum Drucken klicken.

Wenn der Benutzer den Befehl zum Drucken über das Menü ausgibt, kann er den Drucker
und die Druckereinstellungen, die zum Ausdrucken der Grid View verwendet werden sol-
len, ändern.

Wählt er stattdessen die Schaltfläche in der Symbolleiste, dann wird der aktuelle Inhalt der
Grid View auf dem Standarddrucker ausgedruckt.

9.9.2  Tabellenansicht in der Vorschau anzeigen
Um eine Vorschau des Ausdrucks anzuzeigen, entweder im Menü File → Print Preview
wählen oder in der Symbolleiste auf die Schaltfläche für die Druckvorschau klicken. Die
nachfolgende Abbildung zeigt ein Beispiel für das Fenster Print preview.

 36 Druckvorschau der Tabellenansicht anzeigen
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9.10  Auswahlmodus
Im Auswahlmodus (siehe Abbildung unten) kann der Bediener auswählen, welche Tanks
und welche Daten für diese Tanks angezeigt werden sollen. Das bedeutet, dass die Tabel-
lenansicht jetzt verwendet werden kann, um eine "On demand"-Ansicht der Tankmessda-
ten bereitzustellen. Einfach ausgedrückt, kann der Bediener die Tanks, die für ihn von
Interesse sind, aus einer Liste der verfügbaren Tanks in den Ansichtsbereich ziehen und
sie so anordnen, wie es in diesem Moment am sinnvollsten ist. Sobald die Vorgänge am
Tank beendet wurden, kann der betreffende Tank wieder aus dem Ansichtsbereich heraus-
gezogen werden, um Platz im Bildschirm freizumachen.

 37 Tabellenansicht im Auswahlmodus

Im Feld auf der linken Seite sind die Tanks nach Produktfamilien gruppiert. Die Zeilen für
Tanks und Trennzeichen können aus diesem Bereich heraus und nach rechts auf die
Tabelle gezogen werden. Zeilen können an jeder beliebigen Stelle in der Tabelle eingefügt
werden.

9.10.1  Einstellungen
Um den Modus der Anzeige Grid View zu ändern, im Menü File → Settings auswählen. Es
öffnet sich das Dialogfenster Grid View Settings.

Über die Option Verwenden Sie Auswahlmodus wird der Modus der Tabellenansicht
gesteuert.

 38 Fenster Grid View Settings
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Description
Im Feld Description kann der Benutzer einen Namen für die jeweilige Instanz des Fensters
Grid View eingeben. Diese Funktion ist bei einem Betrieb mit mehreren Anzeigen nütz-
lich, wo die Möglichkeit besteht, dass mehrere Tabellen im Bildschirm angezeigt werden
und jede davon eine bestimmte Rolle erfüllt.

Use Select Mode
Das Kontrollkästchen Use Select Mode steuert die Bildschirmanzeige. Wenn es ausge-
wählt ist, kann der Bediener festlegen, welche Tanks angezeigt werden sollen, indem er sie
auf das Raster zieht. Auf der linken Seite des Bildschirms wird eine Liste angezeigt, die im
Standardmodus nicht vorhanden ist.

Display Each Tank Once Only
Wenn dieses Kontrollkästchen ausgewählt ist, wird verhindert, dass der Bediener densel-
ben Tank mehr als einmal zur Tabellenansicht hinzufügt. Dies wird erreicht, indem der
Tank aus der Auswahlliste auf der linken Seite entfernt wird, sobald er zur Tabellenansicht
hinzugefügt wurde.

Show All Tanks Group
Ist dieses Kontrollkästchen ausgewählt, wird dem Benutzer in der Auswahlliste links im
Bildschirm eine Gruppe mit der Bezeichnung All Tanks angezeigt.

Group By
Typischerweise werden in der Auswahlliste links im Bildschirm die Tanks gruppiert, um
das Hinzufügen eines Tankstandorts zur Tabellenansicht zu vereinfachen. Die Tanks in der
Liste können nach Produkt oder statischer Gruppe oder alternativ auch gar nicht zu Grup-
pen zusammengefasst werden.

Sort By
In der Auswahlliste links im Bildschirm können die Tanks entweder in alphabetischer Rei-
henfolge nach Name sortiert werden oder in der Tankreihenfolge, wie sie in der Anzeige
Tank Groups definiert ist.

Die Optionen zum Filtern nach Alarmzustand, Auswählen von Gruppen oder Suchen
nach spezifischen Tanks stehen im Auswahlmodus nicht zur Verfügung. Der Benutzer
kann Tanks zur Tabelle hinzufügen, indem er entweder die Kopfzeile einer Gruppe auf
die Tabelle zieht (in diesem Fall werden alle in der Gruppe enthaltenen Tanks hinzu-
gefügt), oder indem er eine Gruppe erweitert und dann einen einzelnen Tank daraus
auf die Tabelle zieht. Alle Gruppen enthalten außerdem ein Trennzeichen, das es dem
Benutzer ermöglicht, Tankgruppen in der Tabelle selbst zu definieren. Die Reihenfolge
der Tanks in der Tabelle lässt sich leicht ändern, indem der gewünschte Tank einfach
an eine neue Position gezogen wird.

9.10.2  Betrieb mit mehreren Anzeigen
Es können mehrere Tabellenansichten gleichzeitig angezeigt werden. Einige dieser Tabel-
len (Raster) können sich im Auswahlmodus, andere im Standardmodus befinden. Die
Bedienung der Tabellen im Auswahlmodus erfolgt unabhängig voneinander. Das heißt,
dass der Benutzer z. B. eine Tabelle im Auswahlmodus für Tanks verwenden kann, die ein
Produkt empfangen, und eine andere Tabelle, um die Be- und Entladevorgänge in den
Tagestanks am Standort zu überwachen. Außerdem kann jede Tabelle andere Datenspal-
ten enthalten und dafür konfiguriert sein, nur die Daten anzuzeigen, die für den laufenden
Vorgang relevant sind. Auf File → New Window klicken.
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9.10.3  Tanks zu einer Tabelle im Auswahlmodus hinzufügen

Einen Tank zur Tabelle hinzufügen:
1. Den Tank in der Auswahlliste links im Fenster suchen.

2. Den Tank anklicken und an die gewünschte Position in der Tabelle ziehen.

 39 Einen Tank im Auswahlmodus hinzufügen

9.10.4  Tanks aus der Tabelle im Auswahlmodus entfernen

Einen Tank aus der Tabelle entfernen:

‣ Auf die Zeile klicken, die entfernt werden soll, und sie mit der Maus aus der Tabelle
ziehen.

 40 Einen Tank aus der Tabelle im Auswahlmodus entfernen

9.10.5  Tanks in der Tabelle im Auswahlmodus umsortieren

Position eines Tanks in der Tabelle ändern:

‣ Auf die Zeile klicken, die verschoben werden soll, und sie mit der Maus an die
gewünschte Position ziehen.
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 41 Tanks in der Tabellenansicht im Auswahlmodus umsortieren

9.10.6  Farben
Die Zellenfarben für Verladung und Eingänge können jetzt über die Anzeige Customise
Colours konfiguriert werden. Diese Anzeige wird über das Menü Grid View aufgerufen:
Options → Customise Colours.

 42 Farben in der Tabellenansicht benutzerspezifisch anpassen

Auf diese Weise können die Farben geändert werden, um Tanks und Felder hervorzuhe-
ben, für die besondere Zustände gelten:
• Alarm
• Error
• Failed
• Manual
• Scan Mode
• Offline
• Load
• Receipt
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10  Erweiterte Gerätekommandos
Gerätebefehle können messgerätespezifisch sein und daher vom Typ des Messgeräts
abhängen.

So werden z. B. für Enraf-Messgeräte die folgenden Funktionen unterstützt:
• Dipping

Stellt die verschiedenen Modi für die Trennschichtmessung zur Verfügung, wie beispiels-
weise Find Water Interface, Find Product Interface und Density Dipping-Funktionen.

• Displacement
Stellt Funktionen bereit, um den Verdränger eines Messgeräts zu steuern.

• Test Gauge Alarm
Bietet die Möglichkeit, die Alarmwerte des 873 Radarmessgeräts automatisch zu testen.

• Maintenance
Ermöglicht es dem Benutzer, das Referenz Level des Messgeräts einzustellen.

• Gauge Items
Hierbei handelt es sich um ein allgemeines Tool, das es dem Benutzer ermöglicht, Daten-
punkte des Messgeräts zu lesen und zu schreiben und die zurückgemeldeten Daten oder
Antworten anzuzeigen.

Andere Messgeräte können andere Befehle und Konfigurationsfunktionen unterstützen.

10.1  Erweiterte Gerätekommandos starten
‣ Im Menü der Home Page die Option Tools → Advanced Device Commands auswählen.

 Die Anwendung wählt automatisch das primäre Messgerät für den Tank aus, wenn
der Tank über mehr als ein Messgerät verfügt. Die Benutzer können anschließend
weitere Messgeräte durch Klicken auf das "+" neben dem Tank auswählen und die
Aufgabe des Messgeräts festlegen.

 43 Anzeige Erweiterte Gerätekommandos
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10.2  Befehle senden
1. In der Liste links im Fenster den gewünschten Tank auswählen. Den Tank durch Kli-

cken auf das "+"-Symbol erweitern (in einer Konfiguration mit mehreren Messgeräten
das Messgerät auswählen).
 Nun stehen die vom Messgerät unterstützten Befehle zur Verfügung.

 44 Messgerätekommando ausführen

2. Den gewünschten Befehl in der Liste auswählen.

3. Alle benötigten Parameter eingeben und auf die Schaltfläche klicken, um den Befehl
abzusenden. Informationen zum Fortschritt des Messgerätebetriebs werden im Feld
am unteren Fensterrand ausgegeben.

10.3  Dip-Funktionen
Diese Funktionen gelten im Allgemeinen für die Servo-Tankmessgeräte der 854er Serie
von Enraf (siehe nachfolgende Abbildung).
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 45 Dip-Befehle mit Dienstprogramm Erweiterte Gerätekommandos

10.3.1  Produkt Messungsmodus
• Sendet den Datenpunkt I1 des Messgeräts.
• Zeigt durchgehend den Status des Messgeräts an.
• Das Messgerät bleibt an I1, bis der Benutzer dem Messgerät einen anderen Befehl

erteilt.

10.3.2  Dichte-Dip
Hier stehen zwei Optionen zur Verfügung:
• Tank Profil
• Interface Profil

‣ Die korrekte Option auswählen und auf Apply klicken.
 Der Befehl wird ausgeführt.

10.3.3  Wasser Messungsmodus
• Sendet den Datenpunkt I3 des Messgeräts.
• Zeigt durchgehend den Status des Messgeräts an.
• Das Messgerät bleibt an I3, bis der Benutzer dem Messgerät einen anderen Befehl

erteilt.

10.4  Verdrängerfunktionen

10.4.1  Lock-Test
Verriegelt den Verdränger an einem vorgegebenen Füllstand, siehe Abbildung unten.
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 46 Erweitertes Gerätekommando: Lock-Test

• Verwendet den Datenpunkt MZ, um den Füllstand für die Verriegelung einzustellen,
gefolgt vom Befehl LT.

• Der Benutzer muss den Füllstand eingeben, an dem der Verdränger verriegelt werden
soll.

10.4.2  Unlock
• Hebt die Verriegelung des Messgeräts an der Verriegelungs- oder Kalibrierposition wie-

der auf.
• Sendet den Datenpunkt UN des Messgeräts.

10.5  Kalibrierung verifizieren
Verifiziert die Kalibrierung des Geräts. Der Verdränger wird nach oben in die Kalibrierkam-
mer des Messgeräts gefahren.
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 47 Sevo-Messgerät kalibrieren

• Verwendet den Datenpunkt CA des Messgeräts.
• Das Messgerät bleibt im Kalibriermodus bis es vom Benutzer einen anderen Befehl

erhält.
• Speichert das Anfangslevel und zeigt es an.
• Zeigt die verschiedenen Zustandsänderungen an, die auftreten können.
• Auf Schaltfläche Unlock klicken, damit der Verdränger wieder in den Produkt Messungs-

modus zurückkehrt.

10.6  Wartung
Messgeräte-Register einstellen, um die Gerätekonfiguration anzupassen.
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 48 Wartungsmodus für ein Gerät aufrufen

10.6.1  Messgerät auf einen neuen Level Dip einstellen
Wenn das Messgerät von den manuellen Dip-Werten des Bedieners abweicht, ist es üblich,
das Gerät wieder auf die Dip-Werte des Bedieners auszurichten.

Der Benutzer muss den neuen Level Dip und das neue Passwort für den Zugriff auf das
Messgerät bereitstellen.

Wie im Folgenden zu sehen ist, nutzt diese Funktion eine komplette Abfolge von Messge-
räte Datenpunkten:

1. Passwort Level mit Messgeräte Datenpunkt W2 einstellen.

2. Referenz Level mit Messgeräte Datenpunkt RL einstellen.

3. Referenz Level mit Messgeräte Datenpunkt AR annehmen.

4. Funktion verlassen und Messgerät mit Messgeräte-Datenpunt EX neu initialisieren.

5. Den Tank auswählen, der einen neuen Level Dip benötigt.

6. Neues Messgeräte Level eingeben.

7. Auf die Schaltfläche Dip klicken.

Während die oben aufgeführte Abfolge von Schritten durchgeführt wird, wird zu jedem
Übergang der Status angezeigt.

Wenn schließlich der EX-Befehl ausgegeben wird, kann es sein, dass die Messgeräte-
daten kurzzeitig nicht angezeigt werden, während sich das Messgerät neu initialisiert.
Nach der Reinitialisierung sollte am Messgerät der neue Füllstandswert ablesbar sein.

10.7  Messgerät Datenpunkte
Diese Funktion gilt nur für Enraf- und Motherwell-Messgeräte.
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 49 Messgerät Datenpunkte mit erweitertem Gerätekommando auslesen

HINWEIS
Die Verwendung dieser Funktion erfordert die genaue Kenntnis der spezifischen
Messausrüstung und ihrer Konfiguration.
‣ Es empfiehlt sich, dass diese Funktion nur von kompetenten Mitarbeitern verwendet

wird.

Diese Funktion ermöglicht es dem Benutzer, jedes beliebige Konfigurationselement des
Messgeräts zu lesen/zu schreiben. Zum Lesen eines gewünschten Konfigurationselements
das gewünschte Element eingeben und auf Apply klicken. Daraufhin wird die entspre-
chende Antwort angezeigt. Zum Schreiben eines Elements das gewünschte Element und
die Daten eingeben, die geschrieben werden sollen. Dann auf Apply klicken.

10.7.1  Enraf Messgerät Datenpunkte

Einheiten Konvertierung
Über diese Registerkarte können die in Tankvision LMS angezeigten Einheiten in die Ein-
heiten konvertiert werden, die für das Messgerät konfiguriert wurden und mit denen es
arbeitet. Um Verwirrung zu vermeiden, empfiehlt Endress+Hauser, die angezeigten Ein-
heiten, sofern möglich, abzuändern, damit sie den Einheiten entsprechen, mit denen das
Messgerät arbeitet. Auf diese Weise entspricht das Format, das für die über das Portable
Enraf Terminal (PET) vorgenommenen Einstellungen verwendet wird, direkt dem Format,
das auf der Registerkarte Messgerät Datenpunkte verwendet werden soll.

Anfrage lesen
Um eine Anfrage zu lesen, brauchen im Feld Messgerät Item Daten keine Daten bereitge-
stellt zu werden. Die Daten werden in die aktuell im System verwendeten Einheiten kon-
vertiert, bevor sie angezeigt werden.
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Datenformat
Wenn Datenpunkte eingerichtet werden, muss der Benutzer die Datenwerte in exakt dem
Format eingeben, das für die ausgewählten Größen/Einheiten geeignet ist, und zwar mit
dem +/- Vorzeichen und der entsprechenden Anzahl von Ziffern vor und nach dem Dezi-
malpunkt. Sollte sich der Benutzer nicht sicher sein, welches das korrekte Format ist, kann
er zuerst den aktuellen Wert des gewünschten Datenpunkts aus dem Messgerät auslesen,
indem er das Feld Item Daten leer lässt.

Der vom Messgerät als Antwort gemeldete Wert wird in dem Format angezeigt, das den
verwendeten Größen/Einheiten entspricht. Danach muss der Benutzer das gleiche Format
wie in der zurückgemeldeten Antwort verwenden, um die Item Daten auf den gewünsch-
ten neuen Wert einzustellen. Beim Einstellen der Datenpunkte muss dem Datenwert ein
Gleichheitszeichen "=" vorangestellt werden.

Die folgenden Größen/Einheiten werden unterstützt
Taste:
• ± Vorzeichen (+/-)
• N Ziffer
• . Dezimalpunkt

Füllstand

Einheiten Format

mm ± N N N N N N . N (Standard)

m ± N N N . N N N N

ft ± N N N . N N N N

in ± N N N N N . N N

f-i-s ± N N ' N N " N N

Temperatur

Einheiten Format

° C ± N N N . N N (Standard)

° F ± N N N . N N

Dichte

Einheiten Format

kg/l ± N N . N N N N N (Standard)

kg/m3 ± N N N N N . N N

lb/ft3 ± N N N . N N N N

° API ± N N N N . N N N

Druck

Einheiten Format

Bar ± N N . N N N N N (Standard)

Pa ± N N N N N N . N

kPa ± N N N N . N N N

lb/in2 ± N N N . N N N N
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10.7.2  Motherwell Messgeräte Datenpunkte
Auf Motherwell Messgeräte Datenpunkte wird nicht die gleiche Funktion zur Einheiten-
konvertierung angewendet. Die im Feld Gauge Item Data eingegebenen Daten werden
unverändert an das Messgerät übertragen. In der Dokumentation zum Motherwell-Gerät
nachschlagen, um das genaue Datenformat zu ermitteln.

Bei Motherwell-Messgeräten kann entweder ein Hexadezimal-Datenpunktcode aus 2-Zif-
fern eingegeben werden (siehe Beschreibung in der Dokumentation zum Motherwell-
Messgerät), oder es kann ein "Kurzcode" für bestimmte Datenelemente verwendet werden.

Kurzcode Bezeichnung

UR Upper Reference Level

RL Referenz Level

HH Füllstandsalarm: High High

HA Füllstandsalarm: High

LA Füllstandsalarm: Low

LL Füllstandsalarm: Low Low
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11  Tank Gruppierung
Das System stellt eine umfassende Palette an Tools und Dienstprogrammen bereit, mit
denen sich die Tanks ganz nach Bedarf des Benutzers organisieren und gruppieren lassen.

Sämtliche Funktionen zur Tankgruppierung stehen im Modul Tank Gruppierung zur Verfü-
gung.

Bei der Gruppierung wird im Allgemeinen zwischen statischen und dynamischen Gruppen
unterschieden.
• Static groups können organisiert werden nach:

• Produkt
• Produktgruppe
• Benutzerdefinierten Tankgruppen

• Dynamic Groups werden automatisch anhand ihrer spezifischen Kriterien definiert.

Die Anzeige des Moduls Tank Gruppierung umfasst ein Dialogfenster mit mehreren Regis-
terkarten. Jede Registerkarte steht für eine der Gruppierungsarten.

Der Zugriff auf bestimmte Gruppierungsfunktionen ist passwortgeschützt. Bei Bedarf wird
der Benutzer zur Anmeldung aufgefordert.

11.1  Statische Gruppen konfigurieren und verwenden
1. Auf Quick View → Tank Groups in der Menüleiste Gruppen klicken, um das Modul

Tank Gruppierung zu starten.

2. Auf die Registerkarte Static Groups klicken.
 Es öffnet sich das Fenster Tank Groups wie unten dargestellt:

 50 Statische Gruppen, die im Dialogfenster zur Tankgruppierung konfiguriert sind
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3. Auf Add... klicken.
 Es öffnet sich die Anzeige Static Groups wie unten dargestellt:

 51 Tanks für eine neue statische Gruppe auswählen

4. Den Namen der Gruppe eingeben und dann in der Liste Available Tanks einen Teil
der verfügbaren Tanks markieren, um sie zur Gruppe hinzuzufügen. Die Tanks erneut
anklicken, um die Markierung aufzuheben und die Tanks aus der Gruppe zu entfer-
nen.

5. Zum Speichern der Gruppe auf OK klicken. Auf Cancel klicken, um die vorgenomme-
nen Änderungen zu verwerfen.

6. Nach der Rückkehr zum Fenster Tank Groups die an allen Gruppen vorgenommenen
Änderungen durch Klicken auf OK speichern. Auf Cancel klicken, um die vorgenom-
menen Änderungen zu verwerfen.
 Die statische Gruppe kann jetzt verwendet werden, indem sie im Menü Static

Groups in der Menüleiste Gruppen ausgewählt wird.

11.1.1  Bestehende statische Gruppe bearbeiten
1. Auf Quick View → Tank Groups in der Menüleiste Gruppen klicken, um das Modul

Tank Gruppierung zu starten.

2. Auf die Registerkarte Static Groups klicken.

3. Die Gruppe auswählen, die bearbeitet werden soll, und auf Edit.. klicken.
 Es öffnet sich die Anzeige Static Groups wie unten dargestellt:

 52 Bestehende statische Tankgruppe bearbeiten

4. Auf die verfügbaren Tanks klicken, um sie zur Gruppe hinzuzufügen oder daraus zu
entfernen. Alle markierten Tanks gehören zur Gruppe.
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5. Zum Speichern der Gruppe auf OK klicken. Auf Cancel klicken, um die vorgenomme-
nen Änderungen zu verwerfen.

6. Auf OK klicken, um die an allen Gruppen vorgenommenen Änderungen zu speichern.
Auf Cancel klicken, um die vorgenommenen Änderungen zu verwerfen.
 Die statische Gruppe kann jetzt in ihrer abgeänderten Form verwendet werden,

indem sie im Menü Static Groups in der Menüleiste Gruppen ausgewählt wird.

11.1.2  Vorhandene statische Gruppe löschen
1. Auf Quick View → Tank Groups in der Menüleiste Gruppen klicken, um das Modul

Tank Gruppierung zu starten.

2. Auf die Registerkarte Static Groups klicken.

3. Die Tankgruppe, die gelöscht werden soll, in der Liste der angezeigten Gruppen aus-
wählen.

4. Auf Delete klicken.

11.2  Produkt Gruppierung
Das System bietet dem Benutzer die Möglichkeit, nur die Tanks anzuzeigen, die ein
bestimmtes Produkt enthalten.

11.2.1  Verwenden einer Produktgruppe
1. Auf Quick View → Tank Groups in der Menüleiste Gruppen klicken, um das Modul

Tank Gruppierung zu starten.

2. Auf die Registerkarte Product Groups klicken.
 Die Liste der verfügbaren Produkte wird angezeigt:

 53 Produktgruppen im Modul Tank Gruppierung anzeigen

Sind mehr Produkte vorhanden als angezeigt werden können, kann es erforderlich
sein, die Bildlaufleisten zu verwenden, um das gewünschte Produkt aufzufinden.

3. Das gewünschte Produkt in der Liste auswählen.
 Es werden alle Tanks aufgelistet, die aktuell dieses Produkt enthalten.

4. Die Produktgruppe kann jetzt verwendet werden, indem sie im Menü Product
Groups in der Menüleiste Gruppen ausgewählt wird.
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Das Produkt, das zum Filtern der Tanks verwendet werden soll, kann ebenfalls im Menü
Product Groups in der Menüleiste Gruppen ausgewählt werden. Die Liste enthält nur Pro-
dukte, die aktuell Tanks zugewiesen sind. Die Produkte werden nach Verwendung sortiert
angezeigt (das Produkt, das den meisten Tanks zugewiesen ist, erscheint an erster Stelle in
der Liste). Wenn aktuell mehr als 12 Produkte zu Tanks zugewiesen sind, werden nur die
12 am häufigsten verwendeten Produkte aufgeführt, zusammen mit einem abschließen-
den Eintrag, über den ein Produktauswahlfenster geöffnet wird:

 54 Produkt in Tank Gruppierung auswählen

5. Ein Produkt kann durch Klicken auf den Pfeil ausgewählt werden. Dadurch öffnet
sich eine Liste aller Produkte, die Tanks zugewiesen sind (auch hier wieder in der
Reihenfolge ihrer Verwendung sortiert). Alternativ kann auch der Name des
gewünschten Produkts eingegeben werden.
 Während der Eingabe des Produktnamens wird eine verkürzte Liste aller Pro-

dukte angezeigt, deren Bezeichnungen mit dem eingegebenen Text übereinstim-
men:

 55 Produktliste filtern

11.3  Produkt Gruppen Totalisierung
Das Fenster Product Group Totaliser wird über die Home Page geöffnet: View → Product
Group Total. Das Fenster Product Group Totaliser zeigt die summierten Volumina für die
Produktgruppen an.

Nähere Informationen hierzu siehe Abbildung unten.

 56 Product Group Totaliser
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11.4  Dynamische Gruppen
Derzeit stellt das System eine Basisfunktion für dynamische Gruppen zur Verfügung, die es
dem Benutzer erlaubt, Tanks anzuzeigen, die bestimmte dynamische Kriterien erfüllen,
z. B. Tanks in Bewegung.

Wenn mit einer dynamischen Gruppe gearbeitet wird, werden Tanks, die nicht länger den
Kriterien entsprechen, automatisch aus der Anzeige entfernt.

Die Anzahl der verfügbaren dynamischen Gruppen ist derzeit fest vorgegeben. Diese Grup-
pen werden automatisch vom System definiert.

11.4.1  Dynamischen Gruppen verwenden
1. Das Modul Tank Gruppierung durch Klicken auf die entsprechende Schaltfläche in der

Symbolleiste laden.

2. Auf die Registerkarte Dynamic Groups klicken.
 Die Liste der verfügbaren dynamischen Gruppen wird angezeigt:

 57 Anzeige der dynamischen Tankgruppen

3. Eine dynamische Gruppe auswählen.
 Die Tanks, die den Kriterien für die angegebene dynamische Gruppe entsprechen,

werden angezeigt. Beispiel: Moving Tanks zeigt alle Tanks an, die ein Produkt in
eine beliebige Richtung verpumpen. Mit dem Kriterium Receipt Tanks werden
dagegen nur die Tanks angezeigt, die derzeit befüllt werden.

11.5  Tanks zur Anzeige auswählen
1. Auf Quick View → Tank Groups klicken, um das Modul Tank Gruppierung zu laden.
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2. Registerkarte Quick View wählen.
 Die Registerkarte Quick View führt die Tanks auf, die auf der Home Page ange-

zeigt werden sollen, siehe Abbildung unten.

 58 Tanks für die Ad-hoc-Ansicht auswählen

3. Die Tanks markieren, die in der Anzeige ausgegeben werden sollen. Die Markierung
wird durch Klicken auf die Tanks in der Liste umgeschaltet. Die Schaltfläche Invert
schaltet die Markierung für alle Tanks um, sodass ausgewählte Tanks abgewählt
werden und umgekehrt.

Um alle Tanks gleichzeitig auszuwählen, auf die Schaltfläche Select All und dann auf
OK klicken. Dadurch werden alle Tanks angezeigt.

Um alle Tanks gleichzeitig abzuwählen, auf die Schaltfläche Deselect All und dann
auf OK klicken. Dadurch werden alle Tanks minimiert.

4. Auf OK klicken, um die ausgewählten Tanks anzuzeigen.
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12  Hilfe und Diagnose
Das System bietet zur Unterstützung des Benutzers eine Hilfe- und Diagnosefunktion.

Ein großer Teil der Hilfe ist im Menü Help auf der Home Page zu finden.

Die im Menü Help verfügbaren Optionen werden in den folgenden Kapiteln detailliert
erläutert.

12.1  Diagnose
Um die Bedeutung der in der Tankansicht ausgegebenen Diagnosecodes (DN Nummern)
anzuzeigen, auf die jeweiligen Diagnosecodes doppelklicken. Dadurch wird das Modul
Diagnostic Codes gestartet.

12.1.1  Modul Diagnose starten
‣ In der Menüleiste auf der Home Page die Option Diagnostics im Menü Help auswäh-

len.
 Siehe nachfolgende Abbildung.

 59 Diagnosecodes

Die erste Spalte enthält die Diagnosecodes, die zweite Spalte eine kurze Definition, und die
letzte Spalte enthält den Namen der Datei, die detailliertere Informationen zu den mögli-
chen Ursachen sowie empfohlene Maßnahmen zur Identifizierung und Behebung des
damit verbundenen Problems bietet. Das rechte Fensterfeld zeigt den Inhalt der jeweiligen
Datei an.

12.1.2  Diagnoseliste ausdrucken
Das Modul Diagnose bietet die Möglichkeit, spezifische Fehlercodes oder eine Liste von
Fehlercodes zusammen mit einer Kurzbeschreibung auszudrucken.

Im Fenster Diagnose stehen folgende Optionen zur Auswahl:
• File → Print → Diagnostics List
• File → Print → Recommended Action
• File → Print Preview → Diagnostics List
• File → Print Preview → Recommended Action
Der Befehl Print sendet den Report direkt an den Windows-Standarddrucker. Der Befehl
Print Preview öffnet eine Anzeige wie in der Abbildung unten dargestellt.
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 60 Druckvorschau des Fensters Diagnose

12.1.3  Datei mit empfohlenen Maßnahmen starten
‣ Um mehr über den Diagnosecode zu erfahren, auf die betreffende Zeile doppelklicken.

 Dadurch wird Windows WordPad gestartet und die Datei mit den empfohlenen
Maßnahmen geöffnet.

Die Abbildung unten zeigt ein typisches Beispiel.

 61 Anzeige der Datei mit den empfohlenen Maßnahmen
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12.2  Versionen
‣ Im Menü auf der Home Page die Optionen Help → Versions auswählen.

 Die Anzeige unten führt Details zu den exe-Dateien auf, aus denen das Tankmess-
system besteht.

 62 Versionen

Mit den Bildlaufleisten scrollen, um die Details zu jeder der aufgeführten Dateien anzuzei-
gen.

12.2.1  Report zu den Modulversionen ausdrucken
Die in der Anzeige Versionen aufgeführten Informationen können als Report ausgedruckt
werden. Dies erfolgt über die Report-Funktion, die in das Fenster Versionen integriert ist.
Hierzu auf File → Print and File → Print Preview klicken.

 63 Druckvorschau der Versionen
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12.3  Info
Das Menü Help, das in der Menüleiste auf der Home Page zu finden ist, enthält eine
Option mit der Bezeichnung About.

Wenn diese Menüoption ausgewählt wird, wird ein Anzeigemodul geladen, das neben
einem Copyright-Vermerk weitere Informationen enthält, darunter die Versionsnummer
der kompletten Anwendung sowie Lizenzdetails und die Person/das Unternehmen, für
die/das die Anwendung Tankvision Professional registriert wurde.

 64 Anzeige About

Diese Informationen sind wertvoll, wenn der Technische Support des Lieferanten kon-
taktiert werden muss. Eine der ersten Fragen, die bei jedem Support-Anruf unweiger-
lich gestellt wird, ist die Frage danach, auf wen die Software registriert ist und wie die
Lizenz-/Build-Nummer der gesamten Anwendung lautet.
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13  Trenderstellung
Wesentliche Funktionen:
• Mehrere gleichzeitige Anzeigen in einer Grafik
• Unabhängige oder gemeinsam genutzte Achsen für jede Prozessvariable
• Tabellarische Anzeige für bessere Lesbarkeit
• Datencursor zum Lesen von Trendwerten
• Unterstützt dynamische Multi-Dimensionen
• Detaillierte Daten durch Zoom-Funktion
• In der Zeit vorwärts und rückwärts scrollen
• Vom Bediener programmierbare Größe der Y-Achse
• Vom Bediener programmierbare Zeitbasis
• Möglichkeit, mehrere Trendvorlagen zu speichern
• Möglichkeit, Trendvorlagen für die Verwendung auf anderen PCs im Netzwerk zu "veröf-

fentlichen"
• Gleichzeitige Anzeige von mehreren Trendvorlagen

13.1  Trenderstellung und Datenprotokollierung
Das System ist standardmäßig mit einem Paket zur Trenderstellung ausgestattet. Ein
Trenddienst protokolliert die Trenddaten auf der Festplatte des Systems.

Es gibt drei Benutzeroberflächen zur Anzeige von Trenddaten:
• Echtzeit-Trend – Zeigt die aktuellen Parameter der Tankstandmessung über maximal

die letzten 12 Stunden an.
• Historischer Trend – Stellt die Parameter der Tankstandmessung grafisch dar.
• Historischer Trend (Tabelle) – Stellt die Zahlen aus der historischen Darstellung für

den Export in andere Systeme bereit.

13.2  Echtzeit-Trend
Die Funktion Echtzeit-Trend kombiniert die Möglichkeit, die letzten 12 Stunden histori-
scher Trenddaten zusammen mit den aktuellen Daten in Echtzeit anzuzeigen.

13.2.1  Echtzeit-Trend starten
Entweder:
• In der Symbolleiste auf der Home Page auf  klicken.
• Im Menü auf der Home Page View → Real-time Trending auswählen.
• Im Menü Dienstmanager die Option Real-time trending auswählen.

Es öffnet sich die Anzeige mit den Parametern der Trenderstellung, wie unten abgebildet.
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 65 Auswahl der Parameter für den Echtzeit-Trend

Einfach ausgedrückt, besteht der Vorgang zum Anzeigen von Trenddaten darin, auszu-
wählen, welche Tankparameter angezeigt werden sollen und wie lange. Die Anzeige Echt-
zeit-Trend ist einfacher aufgebaut als die anderen Anzeigen, weil der Zeitrahmen für diese
Anzeige immer zu dem Zeitpunkt beginnt, an dem der Trend erstellt wird, und dann eine
variable Anzahl von Stunden in der Vergangenheit zurückreicht.

13.2.2  Zeitspanne für Echtzeitdaten
Der erste Parameter, der eingegeben wird, ist die Zeitspanne, die in der Grafik dargestellt
werden soll, siehe Abbildung unten.

 66 Zeitspanne auf einem Einzelserversystem eingeben

Interval gibt die Anzahl von Stunden in der Vergangenheit an, die angezeigt werden sol-
len. Es können maximal 12 Stunden angezeigt werden.

Plot Interval gibt die Zeit (in Sekunden) an, die zwischen den aufeinanderfolgenden
Datenpunkten in der Grafik liegt. Das maximale Intervall beträgt 900 Sekunden – norma-
lerweise sind keine Zeitspannen von weniger als 30 Sekunden erforderlich, es sei denn, die
Konfiguration des Trenddienstes wurde verändert.

13.2.3  Weitere Konfigurationsmöglichkeiten
Nähere Informationen zu den allgemeinen Konfigurationsoptionen siehe Kapitel "Allge-
meine Trendkonfiguration".
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Optionen für redundante Systeme
Wenn in einer redundanten Serverumgebung der Client zur Trenderstellung auf einem Cli-
ent-System ausgeführt wird, besteht die zusätzliche Möglichkeit, die Quell-Servers wie in
der Abbildung unten auszuwählen. Der Benutzer kann entweder das redundante Server-
paar oder die Option Automatic auswählen, durch die der Server verwendet wird, den die
Home Page aktuell als Datenquelle verwendet. Zudem kann die Option Attempt to patch
missing data using the other server genutzt werden, wenn der ausgewählte Server über
einen unvollständigen Datensatz für die eingestellte Zeitspanne verfügt.

 67 Zeitspanne auf einem redundanten Serversystem eingeben

Der Patch-Mechanismus füllt die Lücken im Datensatz des ersten Servers mit Daten des
anderen Servers. Wenn beide Server für die gleichen Zeitpunkte Lücken in ihren Datensät-
zen aufweisen, was typisch für ein Problem mit einem Feldinstrument ist, dann bleiben
diese Lücken bestehen. Die Funktion ist nur dann nützlich, wenn einer der beiden Server
während des für die Trenddarstellung gewählten Zeitraums ausgefallen war.

13.3  Historischer Trend
Der historische Trend ähnelt dem Echtzeit-Trend insofern, dass beide zum Ziel haben, die
Tankmessdaten über einen bestimmten Zeitraum grafisch darzustellen. Der Unterschied
besteht darin, dass die im historischen Trend dargestellten Daten keine Live-Daten sind
(d. h. die Darstellung lässt sich nicht nach links scrollen) und dass auch kein Zeitlimit von
12 Stunden für den Darstellungszeitraum gilt.

13.3.1  Historischen Trend starten
Entweder:
• In der Symbolleiste auf der Home Page auf  klicken.
• Im Menü auf der Home Page View → Historical Trending auswählen.
• Im Menü Dienstmanager die Option Historical trending auswählen.

Es öffnet sich die Anzeige mit den Parametern der Trenderstellung, wie unten abgebildet.
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 68 Auswahl der Parameter für den historischen Trend

13.3.2  Daten für die grafische Darstellung von historischen Trends
Um den Zeitraum festzulegen, in dem die Daten in der Grafik dargestellt werden sollen,
müssen Date/Time Start, Date/Time End und Plot Interval festgelegt werden. Die Optio-
nen Startzeit und Endzeit sind selbsterklärend, und die Plot Interval gibt die Zeit zwischen
benachbarten Punkten in der Grafik an. Die maximale Plot Interval beträgt
900 Sekunden.

 69 Auswahl der Daten für die Darstellung des historischen Trends

Große Datensätze benötigen lange Zeit für die grafische Darstellung. Sollen die Daten
eines Monats, abgebildet in Intervallen von 5 Sekunden für 20 Felder dargestellt wer-
den, ist viel Zeit erforderlich, um alle Daten für die Grafik zu kompilieren.

Standardmäßig ist der Server, der den Trend erstellt, so konfiguriert, dass Trenddaten
nach 90 Tagen gelöscht werden. Wenn eine Zeitspanne ausgewählt wird, die vor den
auf dem Server verfügbaren Daten liegt, dann wird eine leere Grafik ausgegeben.

13.3.3  Weitere Konfigurationsmöglichkeiten
Nähere Informationen zu den allgemeinen Konfigurationsoptionen siehe Kapitel "Allge-
meine Trendkonfiguration".

Optionen für redundante Systeme
Bei einem redundanten System stehen einige zusätzliche Optionen zur Verfügung, wie in
der Abbildung unten dargestellt.
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 70 Eingabe von ausgewählten Datensätzen für eine historische Trenddarstellung auf einem redundanten Sys-
tem

Es kann ein spezifischer Server als Datenquelle ausgewählt oder die Option Automatic
verwendet werden, durch die dann automatisch der Server ausgewählt wird, den die Home
Page aktuell als Datenquelle verwendet. Mit der Option Attempt to patch missing data
using the other server können Lücken in den Daten des Quellservers mit den Daten
gefüllt werden, die vom redundanten Server bezogen wurden.

13.4  Historischer Trend (Tabelle)
In den meisten Fällen reicht die grafische Darstellung der Trenddaten, wie sie vom Echt-
zeit- und Historischen Trend bereitgestellt werden, aus, um die Vorgänge in einer Tankan-
lage zu visualisieren. Sollte eine eingehendere Analyse der zugrundeliegenden Daten
erforderlich sein, steht eine Tabellenansicht zur Verfügung, deren Hauptfunktion darin
besteht, Daten in ein Format zu exportieren, in dem sie von anderen Systemen genutzt
werden können.

13.4.1  Historischen Trend (Tabelle) starten
Entweder:
• In der Symbolleiste auf der Home Page auf  klicken.
• Im Menü auf der Home Page View → Historical Trending (Table) auswählen.
• Im Menü Dienstmanager die Option Historical Trending (Table) auswählen.

Es öffnet sich die Anzeige mit den Parametern der Trenderstellung, wie unten abgebildet.

 71 Historischen Trenddaten für die Tabellenansicht auswählen
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13.4.2  Historischen Trenddaten für die Tabellenansicht auswählen
Der Auswahlprozess für die tabellarische Datendarstellung ist ähnlich wie bei der grafi-
schen Ansicht (siehe Kapitel "Daten für die grafische Darstellung von historischen Trends").
Der einzige Unterschied besteht darin, dass der Benutzer auswählen kann, wie diese Daten
gemeldet werden.

Trenddaten der Tankstandmessung speichern
Die Trenddaten werden vom Trenddienst erfasst und auf dem Server gespeichert. Der
Dienst erfüllt zwei Aufgaben: Zum einen erfasst er Live-Tankmessdaten und speichert sie
in Dateien auf dem Computer, und zum anderen stellt er diese Daten auf Anfrage den Cli-
ent-Anwendungen bereit.

Zur Erfassung der Daten fragt der Dienst regelmäßig die verfügbaren Tankmessdaten ab
(typischerweise alle 10 Sekunden) und zeichnet nur die Parameter auf, die sich seit der
letzten Abfrage vor 10 Sekunden geändert haben. Zur genaueren Erläuterung soll hier das
Beispiel des Produktfüllstands in einem Tank dienen: Wenn sich der Produktfüllstand
eines Tanks seit der letzten Abfrage nicht geändert hat, werden bei der aktuellen Abfrage
keine Füllstandsdaten für diesen Tank aufgezeichnet. Dies wirkt sich auf die Daten aus, die
in der tabellarischen Ansicht des historischen Trends dargestellt werden.

Historische Daten auswählen
Die allgemeinen Optionen zur Auswahl von Trenddaten gelten auch für diese Trenddaten-
anzeige (siehe Kapitel "Allgemeine Trendkonfiguration").

Zusätzlich werden 3 weitere Optionen angeboten, wenn der Benutzer die Option Histori-
scher Trend auswählt. Die Auswahl dieser Optionen führt dazu, dass die in der Tabellenan-
sicht ausgegebenen Daten variieren. Diese Auswahl kann den statistischen Wert der
Informationen beeinflussen.

Option:
• Logged Values Only

Prozessvariablen, die im Datensatz keinen Wert enthalten, bleiben leer.
• All Implied Values

Die Datensätze, die bei der Auswahl von Logged Values Only leer bleiben, werden mit
dem letzten bekannten Wert aus früheren Abfragen gefüllt.

• Interpolated Values
Die Datensätze, die bei der Auswahl von Logged Values Only leer bleiben, werden mit
einem Wert gefüllt, der mithilfe der linearen Interpolation aus den realen Werten vor
und nach dem Zeitpunkt dieses Datensatzes synthetisiert wurde.
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 72 Tabellarische Ansicht von historischen Trenddaten

13.5  Allgemeine Trendkonfiguration
Viele der Vorgehensweisen zum Entwurf einer Trenddarstellung werden ebenso für die
Darstellung von Echtzeit-Trends als auch von historischen Trends und bis zu einem gewis-
sen Maß auch für die tabellarische Ansicht von Trenddaten verwendet. Diese Vorgehens-
weisen werden im Folgenden näher erläutert.

13.5.1  Gemeinsam genutzte Achsen
Wenn zusammenhängende Teile von Informationen dargestellt werden sollen, ist es oft-
mals wünschenswert, sie auf einer gemeinsamen Achse abzubilden, sodass der Benutzer
die Werte der Trendlinien an verschiedenen Punkten innerhalb der dargestellten Zeit-
spanne miteinander vergleichen kann.

Sollen z. B. der Produktfüllstand und der freie Wasserfüllstand eines Tanks zusammen
abgebildet werden, dann würde der Benutzer sie auf derselben Achse darstellen, da zu
erwarten ist, dass sich der Wasserfüllstand irgendwo unterhalb des Produktfüllstands
befindet. Wenn der Benutzer sie dagegen auf separaten Achsen darstellt und die Option
zur automatischen Skalierung verwendet, dann erscheint der Wasserfüllstand typischer-
weise als flache, horizontale Linie im Zentrum der Grafik, während sich der Produktfüll-
stand über und unter dieser Linie bewegt.

Durch Verwendung einer gemeinsamen Achse wird der freie Wasserfüllstand am unteren
Rand der Grafik mit einem darüber fluktuierenden Füllstand und in einer Skala mit den
Werten dargestellt.

13.5.2  Gemeinsam genutzte Achse hinzufügen
Auf Add klicken, um eine gemeinsam genutzte Achse zu erzeugen. Dadurch wird eine
neue Achse erzeugt, die zunächst für den Füllstand gilt und die den Namen New Axis hat,
wie unten dargestellt ist.
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 73 Erzeugen einer neuen gemeinsamen Achse

Den Namen der Achse durch Eingabe eines geeigneten Namens im Textfeld Caption
ändern und dann den gewünschten Typ für die Achse auswählen. Wenn die Option Auto
Scale ausgewählt bleibt (Häkchen gesetzt), dann wird die Achse skaliert, um so viel wie
möglich des Darstellungsbereichs auszufüllen und so die Werte der Trenddaten einzupas-
sen. Dies kann zur Folge haben, dass geringfügige Schwankungen wesentlich größer
erscheinen als sie eigentlich sind! Soll die automatische Skalierung nicht verwendet wer-
den, dann die Option abwählen, aber geeignete Mindest- und Höchstwerte für die Achse
eingeben.

13.5.3  Felder hinzufügen
Es können unbeschränkt viele Felder angezeigt werden. Wird jedoch eine hohe Zahl von
Feldern zur selben Trendvorlage hinzugefügt, kann das dazu führen, dass sich die Daten
schwer interpretieren lassen. Es ist daher besser, mehrere Vorlagen mit weniger Trendfel-
dern pro Vorlage zu erzeugen.

Auf Add Field klicken, um wie unten dargestellt ein Trendfeld hinzuzufügen.

 74 Hinzufügen von Feldern zur Trendgrafik

Zuerst einen Tank in der Dropdown-Liste und danach die Prozessvariable für den Tank
auswählen, die im Trend dargestellt werden soll.

Sofern verfügbar, kann eine Shared Axis für 1 oder mehr Prozessvariablen verwendet
werden, indem das Kontrollkästchen aktiviert (Häkchen gesetzt) und dann die
gewünschte gemeinsame Achse in der Dropdown-Liste ausgewählt wird. Bitte beach-
ten: In der Liste werden nur gemeinsam genutzte Achsen aufgeführt, die für die im
Trend dargestellte Prozessvariable relevant sind. Das bedeutet, dass bei der Erstellung
z. B. eines Füllstandstrends keine Temperaturachse angezeigt wird.

Optional können bei Bedarf auch Mindest- und Höchstwerte für die Y-Achse eingegeben
werden. Je geringer der Bereich zwischen dem Mindest- und dem Höchstwert ist, umso
detaillierter ist die Ansicht. Zur Eingabe der Mindest- und Höchstwerte muss zuerst sicher-
gestellt werden, dass keine gemeinsam genutzte Achse verwendet wird. Außerdem muss
das Kontrollkästchen Auto neben dem Feld abgewählt werden (Häkchen löschen).

Den Vorgang wiederholen, um weitere Trendfelder hinzuzufügen.
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Auf  klicken, um ein Trendfeld aus der Liste zu entfernen. Die Abbildung unten zeigt ein
Beispiel für eine Trendvorlage.

 75 Beispiel für eine Anzeige mit Trendfeldern

Linienfarbe und -art
Farbe und Art der einzelnen Linien in der Grafik können zur einfachen Identifizierung
angepasst werden. Auf  am Ende der Linie klicken, um die Palette mit Linienarten und -
farben anzuzeigen (siehe unten).

 76 Farbe und Art für die Linien in der Grafik festlegen

Gewünschte Linienart und -farbe auswählen und auf OK klicken. Auf Use Defaults kli-
cken, um zu den Standardeinstellungen zurückzukehren.

Die Trendanzeige wird nun entsprechend konfiguriert, um die gewünschten Daten anzu-
zeigen.
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Trendverlauf anzeigen
Nachdem die Felder konfiguriert wurden, kann die Grafik durch Klicken auf die Taste für
Zurück angezeigt werden.

 77 Beispiel für eine Trendgrafik mit in Betrieb befindlichen Tanks

13.5.4  Werte im Trend suchen
Wenn für die Grafik ein anderer Auswahlmodus als Keine ausgewählt wurde, dann kön-
nen die Werte der Prozessvariablen zu einem bestimmten Zeitpunkt angezeigt werden.
Um die Einstellung für den Auswahlmodus der Grafik zu ändern, auf File klicken, um zur
Anzeige Info zurückzukehren. Danach auf Advanced… klicken. In dem Fenster, das sich
öffnet, auf Selection Mode klicken und dann den gewünschten Auswahlmodus auswäh-
len.

 78 Anzeige zur Auswahl der Linienart
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 79 Auswahl des gewünschten Auswahlmodus

Folgende Optionen stehen zur Auswahl:
• Default – Es wird der standardmäßige Auswahlmodus verwendet (die ausgewählte Lini-

enfarbe und -art werden dadurch nicht verändert, der Benutzer muss auf Use Defaults
klicken, um Linienfarbe und -art auf die Vorgabewerte zurückzusetzen).

• None – Es kann kein Zeitpunkt in der Grafik ausgewählt werden, und die Werte der Pro-
zessvariablen werden nicht angezeigt.

• Fixed Time – In der Grafik kann ein Zeitpunkt ausgewählt werden, und die entsprechen-
den Werte der Prozessvariablen werden links in der Anzeige ausgegeben. Wenn neue
Werte zur Grafik hinzugefügt werden, wandert die Linie, die die Auswahl anzeigt, nach
links, bleibt aber immer am gleichen Zeitpunkt.

• Fixed Location – In der Grafik kann ein Zeitpunkt ausgewählt werden, und die ent-
sprechenden Werte der Prozessvariablen werden links in der Anzeige ausgegeben.
Wenn neue Werte zur Grafik hinzugefügt werden, bleibt die Linie, die die Auswahl
anzeigt, an derselben Stelle, während die Werte der Prozessvariablen darüber hinaus
wandern.

Wenn unter Selection Mode eine andere Option als None eingestellt ist, kann der Benut-
zer die aktuelle Auswahl mithilfe der linken und rechten Pfeiltaste in der Zeit vorwärts und
rückwärts verschieben. Soll die Auswahl um einen größeren Zeitraum verschoben werden,
die Umschalttaste drücken und gleichzeitig die rechte oder linke Pfeiltaste verwenden.

13.5.5  Zoomen, um mehr Details anzeigen
Das Trendmodul ermöglicht es dem Benutzer, die Darstellung der Trenddaten zu vergrö-
ßern, um sie genauer zu untersuchen und Trends im Detail anzuzeigen. Wenn für den
aktuellen Auswahlmodus eine andere Option als None ausgewählt ist, dann muss die
Grafik zuerst in den Zoom-Modus versetzt werden. Hierzu in der Symbolleiste auf die
Zoom-Schaltfläche  klicken.

Bereich im Trend identifizieren, der im Detail angezeigt werden soll
Mit der Maus ein Feld rund um den gewünschten Bereich ziehen. Hierzu mit der Maus auf
den Bereich zeigen und mit der linken Maustaste klicken. Die linke Maustaste gedrückt
halten und den Mauscursor nach links oder rechts ziehen. Es erscheint ein Rahmen, der in
der Größe anpassbar ist. Diesen Rahmen um den gewünschten Bereich legen und die
Maustaste loslassen.

Das System vergrößert nun den ausgewählten Bereich. Zudem erscheinen eine horizontale
und eine vertikale Bildlaufleiste, mit denen sich der Benutzer durch die Daten bewegen
kann, die in der Vergrößerung angezeigt werden. Mithilfe der gleichen Vorgehensweise
können Teile dieses Bereichs noch weiter vergrößert werden.

13.5.6  Verkleinern
Um den Modus Zoomen zu verlassen und zum Auswahlmodus zurückzukehren, in der
Symbolleiste auf die Schaltfläche Rückgängig Zoom  klicken. Jetzt kann der Benutzer
anstelle eines Bereichs, der vergrößert dargestellt werden soll, einen Zeitpunkt in der Gra-
fik auswählen, indem er einfach auf den gewünschten Zeitpunkt klickt.
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13.6  Trendvorlagen
Um Zeit und Aufwand zu reduzieren, können die Auswahlkriterien und Anzeigeoptionen,
die der Benutzer für die Erzeugung der Trenddatenanzeige festlegt, gespeichert und bei
Bedarf jederzeit wieder abgerufen und verwendet werden.

Vorlagen enthalten die Auswahlkriterien sowie Informationen zu Linienfarbe und -art und
können entweder als Datei auf der Festplatte des Computers oder zentral in der Datenbank
des Tankmesssystems gespeichert werden.

13.6.1  Trendvorlage speichern
Durch das Speichern einer Vorlage wird eine MTTRT-Datei auf der Festplatte des Compu-
ters abgelegt. Gespeicherte Vorlagen können immer nur auf dem Computer aufgerufen
werden, auf dem sie gespeichert wurden.

In der Anzeige mit den Trendparametern auf Save oder Save As klicken.

13.6.2  Trendvorlage veröffentlichen
Das Veröffentlichen einer Vorlage ähnelt dem Speichern von Vorlagen. Der Unterschied
besteht darin, dass die Datei in diesem Fall auf dem Server (oder den Servern, wenn es sich
um ein redundantes System handelt) in der Datenbank des Tankmesssystems gespeichert
wird. Einmal veröffentlicht, kann die Vorlage auf allen Computern im Netzwerk des Tank-
messsystems aufgerufen werden.

In der Anzeige mit den Trendparametern auf Publish klicken.

13.6.3  Trendvorlage öffnen
In der Anzeige mit den Trendparametern auf Open klicken.

 80 Trendvorlage öffnen
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Das System bietet drei Optionen:
• Recent Templates – Zeigt eine Liste der zuletzt verwendeten Vorlagen an.
• Computer – Bietet die Möglichkeit, die Festplatte des Computers nach zuvor gespeicher-

ten MTTRT-Dateien zu durchsuchen.
• Published Templates – Zeigt eine Liste aller veröffentlichten Vorlagen an.

13.7  Trenddaten ausdrucken
Wenn ein Papierausdruck der Trendgrafik benötigt wird, zuerst die gewünschte Ansicht
auswählen und dann in der Anzeige mit den Trendparametern auf Print klicken. Es wird
eine Vorschau des Reports angezeigt, über die der Druckauftrag an einen Drucker gesendet
werden kann.

Jeder ausgewählte Zeitpunkt oder vergrößerte Bereich, den der Benutzer auf die grafi-
sche Anzeige angewendet hat, wird im Ausdruck wiedergegeben.

13.8  Trenddaten exportieren
Der Echtzeit-Trend und der Historische Trend (Grafik) können verwendet werden, um
Trenddaten im grafischen oder im .CSV-Format zu exportieren. Das Modul Historischer
Trend (Tabelle) kann nur zum Exportieren der Trenddaten als .CSV-Datei verwendet wer-
den. Nachdem eine Vorlage für die Trenderstellung eingerichtet wurde, in der Konfigurati-
onsansicht auf Export klicken.

Es öffnet sich die folgende Anzeige für Real Time Trending und Historical Trending
(Grafik):

 81 Exportieren von Daten aus der Trendansicht

13.8.1  Grafiken exportieren
Um die Daten als Grafik zu exportieren, Export Graph auswählen und auf Export klicken.

Es öffnet sich das normale Windows-Dialogfenster zum Speichern von Dateien. Durch die
Option Include selected variables werden der Auswahlpunkt und die Werte der Trend-
grafik zu einem bestimmten Zeitpunkt hinzugefügt, wie unten dargestellt ist.



Trenderstellung Tankvision Professional NXA85

76 Endress+Hauser

 82 Export inklusive ausgewählter Werte

13.8.2  Daten exportieren
Zum Exportieren der Datenwerte einfach Export Data auswählen.

Die Funktion Historical Trending (Table) kann nur Daten exportieren, d. h. es gibt
keine Option zum Exportieren von Grafiken.

 83 Optionen zum Exportieren von Trenddaten

Export Headers
Wenn diese Option ausgewählt ist, enthält der erste Datensatz in der exportierten Datei
keine Daten, sondern die Spaltenüberschriften der Tabelle.

Data
Diese Option steuert, wie die Datenwerte bestimmt werden. Eine Erläuterung der Optionen
siehe Kapitel "Historischer Trend (Tabelle)".
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Data Format
Diese Option steuert, wie die Daten formatiert werden.
• Die Trenddaten als Formatted Data zu exportieren, bedeutet, dass der Inhalt der CSV-

Datei exakt den in der Tabelle angezeigten Daten entspricht. (Hierbei ist Folgendes zu
beachten: Wenn die CSV-Datei mit Microsoft Excel geöffnet wird, formatiert die Anwen-
dung die Daten möglicherweise neu, bevor sie sie anzeigt).

• Die Trenddaten als Raw Data in Base Units zu exportieren, führt dazu, dass in der CSV-
Datei die Rohdaten aus der Trenddatendatei enthalten sind. Das bedeutet, dass alle For-
matierungsinformationen (z. B. die Anzahl der Dezimalstellen) und
Werteübersetzungen (z. B. Alarmzustände) nicht exportiert werden, die CSV-Datei also
nur numerische Daten enthält.

• Die Trenddaten als Raw Data zu exportieren, ähnelt der eben beschriebenen Option. Der
Unterschied besteht darin, dass die Werte für Felder, deren Daten angezeigt werden
können und die verschiedene Einheiten verwenden (z. B. Füllstände, Temperaturen etc.),
mithilfe der Einheiten konvertiert werden, die aktuell für diesen Typ von Feld ausge-
wählt sind.

Auf Export klicken, um einen Dateinamen und einen Speicherort auszuwählen, und dann
auf Save klicken.

13.9  Optionen
Durch Klicken auf die Schaltfläche Options kann der Benutzer veröffentlichte Vorlagen
steuern und löschen und die Standardoptionen für die Darstellung von Trendverläufen
festlegen.

 84 Optionen in der Trendansicht

13.9.1  Vorlagen anheften
Zum leichteren Auffinden können Vorlagen an den Anfang der Liste gestellt ("geheftet")
werden.

Es gibt 2 Möglichkeiten, Vorlagen anzuheften:
• Mit der rechten Maustaste auf die gewünschte Vorlage und dann auf Pin to list klicken.
• Mit der Maus über die gewünschte Vorlage fahren und auf das Pin-Symbol klicken.
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Angeheftete Vorlagen können von der Liste wieder gelöst (losgeheftet) werden, indem auf
das Pin-Symbol für Losheften geklickt wird. Dieses Symbol wird auf angehefteten Vorlagen
kontinuierlich angezeigt.

13.9.2  Vorlagen löschen
Veröffentlichte Vorlagen, die nicht länger benötigt werden, können gelöscht werden.

Zum Löschen einer Vorlage auf die Vorlage klicken, um sie zu markieren, und dann auf
Delete klicken. Das Löschen von mehreren Vorlagen gleichzeitig ist ebenfalls möglich.

 85 Löschen einer veröffentlichten Vorlage

13.9.3  Optionen für die grafische Darstellung
Auf der Registerkarte Graphing kann der Benutzer das Erscheinungsbild der Standardli-
nien für Selection und Series anpassen.

 86 Definition des standardmäßigen Erscheinungsbilds von Serien in Grafiken
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Selection
• Colour – Auswählen der Farbe, die standardmäßig für die vertikale Auswahllinie ver-

wendet werden soll.
• Line Style – Auswahl der Linienart, die standardmäßig für die vertikale Auswahllinie

verwendet werden soll.
• Selection Mode – Auswahl des Auswahlmodus, der standardmäßig für die grafischen

Trenddarstellungen verwendet werden soll. Nähere Informationen zu Auswahlmodi
siehe Kapitel "Werte im Trend suchen".

Series
Das Modul zur Trenddarstellung wird mit einer einzelnen, konfigurierten Standardserie
bereitgestellt. Die Einstellungen dafür können wie folgt geändert werden:
• Colour – Auswahl der Farbe für die Linie, mit der die Serie dargestellt wird.
• Text Colour – Auswahl der Farbe, in der der Text auf der Schaltfläche dargestellt wer-

den soll.
• Line Style – Auswahl der Linienart für die Linie, mit der die Serie dargestellt werden

soll.

Es können weitere Vorgabewerte für Serien hinzugefügt werden. Hierzu auf Add klicken
und die Werte auf ähnliche Weise konfigurieren.

Wenn die Grafik mehr Tankstandparameter enthält, als Standardlinienarten für Serien
vorhanden sind, dann wird das Muster der Vorgabewerte ab Serie 1 wiederholt.
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14  Bestandsrechner
Das System ist standardmäßig mit einem Bestandsrechner ausgestattet.

Hauptzweck des Bestandsrechners ist, dem Benutzer ein Mittel bereitzustellen, mit dem
sich die Tankbestände unter derzeit nicht vorhandenen Bedingungen berechnen lassen.

So kann er z. B. als Rechner für "Was wäre, wenn"-Situationen verwendet werden, d. h. es
kann beispielsweise berechnet werden, wie die abschließende Tanksituation wäre, wenn
ein Tank X Liter eines Produkts empfangen oder abgeben soll.

Außerdem kann der Bestandsrechner als einfaches Planungswerkzeug vor dem Abgeben
und/oder Empfangen eines Produkts eingesetzt werden.

14.1  Bestandsrechner starten
Auf die Schaltfläche für den Bestandsrechner in der Symbolleiste klicken .

Das Modul Inventory Calculator wird geladen. Die Abbildung unten zeigt ein typisches
Beispiel. Bei dem Inventory Calculator handelt es sich um eine Anzeige mit mehreren
Registerkarten, die einen einfachen Tankrechner, den Verpumpungsrechner für Entlee-
ren/Eingänge, einen Umrechner für die Einheiten der Messungen und einen Rechner für
die lineare Interpolation bereitstellt.

 87 Fenster Inventory Calculator

14.2  Tankrechner
Der Tankrechner bietet dem Benutzer die Möglichkeit, die Tankbestände unter vom Benut-
zer angegebenen Bedingungen zu berechnen.

14.2.1  Aktuelle Tankdaten anzeigen
In der Dropdown-Liste einen Tank auswählen.
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Für den ausgewählten Tank werden nun die aktuellen Tankstand- und Bestandsdaten
zusammen mit der aktuell für den Tank konfigurierten API-Tabelle angezeigt. Einige
Datenwerte hängen von der Auswahl ab, die in den Dropdown-Feldern vorgenommen
wurde, und sind daher in manchen Konfigurationen möglicherweise nicht sichtbar.

14.2.2  Benutzerdefinierte Kriterien eingeben
Der Benutzer kann folgende Daten eingeben:
• Product Level
• Product Temperature
• Product Density
• Water Level
• Pressure
• Molecular Mass
• Temperature Coefficient
• Density Correction Factor
• API Table
Einige der Datenfelder sind nicht in allen Fällen zutreffend. Die Benutzeroberfläche fügt
neue Datenfelder ein, wenn sie für die aktuellen Berechnungseinstellungen erforderlich
sind.

Felder, die bearbeitet werden können, sind in der Anzeige deutlich durch einen weißen
Hintergrund gekennzeichnet.

Zum Berechnen der Daten wie folgt vorgehen:
1. Eines der editierbaren Felder bearbeiten. Um beispielsweise den Tankbestand an

einem anderen Füllstand anzuzeigen, einfach den aktuellen Füllstandswert löschen
oder mit dem neuen Wert überschreiben.

2. Auf die Schaltfläche Berechnen klicken .
 Die Bestandsparameter werden für die neuen Daten neu berechnet.

14.3  Verpumpungsrechner
Mit dem Verpumpungsrechner kann der Benutzer das Einfüllen oder Ablassen von Pro-
dukt aus einem Tank simulieren. Mit diesem Tool kann der Zielfüllstand für die Verpum-
pung geschätzt und eine einfache Verpumpung eingerichtet werden.

 88 Berechnung einer Bewegung mit dem Bestandsrechner
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1. Vor der Eingabe der Verpumpungsdetails einen Tank in der Liste auswählen.
 Die aktuellen Tankbedingungen werden angezeigt.

2. Die Verpumpungsart auswählen, die ausgeführt werden soll: Load (Abpumpen),
Receipt (in den Tank pumpen), Fill oder Empty.

Es gibt verschiedene Methoden zur Angabe der Verpumpungsmenge, so u. a. verschiedene
Volumina, Gewichte und Massen. In den meisten Fällen kann die Verpumpungsmenge
auch als absolute oder relative Menge angegeben werden.

Eine detaillierte Beschreibung dieser Optionen ist im Handbuch Einfache Bewegungen
(BA01653G) zu finden.

3. Die abzugebende oder zu empfangende Menge eingeben, es sei denn, der Wert wird
bereits durch die Verpumpungsart impliziert.

4. Auf Calculate klicken , um die Bedingungen im Tank nach der Verpumpung annä-
hernd zu berechnen. Wenn der Benutzer einen berechneten Vorgang durchführen
möchte, kann er Offsets für den Voralarm eingeben und auf Set Movement klicken,
um die Verpumpung zu starten. Die Funktion für einfache Verpumpungen wird im
Handbuch Einfache Bewegungen (BA01653G) ausführlich beschrieben.

5. Um die Eingaben in diesem Fenster zu löschen und das Fenster zurückzusetzen, auf
Clear klicken .

14.4  Interpolation
Bei der mit Interpolation beschrifteten Registerkarte handelt es sich um ein sehr einfaches
Berechnungswerkzeug für lineare Interpolationen. Es ermöglicht dem Benutzer, die Daten
direkt aus einer Reihe von Kalibriertafeln einzugeben und dann das Volumen an einem
unbekannten Füllstand durch eine lineare Interpolation zu berechnen.

 89 Berechnung durch Interpolation

14.5  Einheiten Konvertierung
Die Registerkarte Einheiten Konvertierung bietet ein einfaches Tool, mit dem der Benutzer
einen Wert in einer Einheit in den entsprechenden Wert in einer anderen Einheit umrech-
nen kann.

Zuerst den Typ des Werts in der Optionsliste auf der linken Seite auswählen. Danach kann
der Benutzer in der Dropdown-Liste die Einheit für den Startwert, seinen numerischen
Wert und dann die Einheit, in die der Wert umgerechnet werden soll, auswählen.
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Auf Calculate klicken, um die Umrechnung vorzunehmen.

 90 Umrechnung von Einheiten

1. Typ des Werts in der Optionsliste auf der linken Seite auswählen.

2. In der Dropdown-Liste die Einheit für den Startwert auswählen.

3. Den numerischen Wert eingeben, der umgerechnet werden soll.

4. Einheit auswählen, in die der Wert umgerechnet werden soll.

5. Auf Calculate klicken .
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15  Scan Controller
Mit dem Tool Scan Controller kann der Scan-/Abfragestatus einzelner Messgeräte einge-
stellt werden. Zum Aufrufen des Scan Controllers im Menü auf der Home Page auf Tools
→ Scan Controller klicken.

 91 Scan controller

Die Details zu allen in der Datenbank konfigurierten Messgeräten werden angezeigt,
inklusive des aktuellen Scan Status.

Auf dieser Seite kann der Abfragestatus für ein oder mehrere Messgeräte in einem einzi-
gen Schritt eingestellt werden.

Messgeräte auswählen
• Zum Auswählen eines Messgeräts in der Tabelle auf das gewünschte Gerät klicken.
• Um mehrere Messgeräte auszuwählen, die Taste Strg drücken und gleichzeitig für jedes

gewünschte Messgerät auf das graue Rechteck klicken, das sich am Anfang jeder Zeile
befindet.

• Alternativ kann auch auf Select All geklickt werden, um alle in der Datenbank enthalte-
nen Messgeräte auszuwählen.

Abfragestatus einstellen
Zum Einstellen des Abfragestatus auf eine der Schaltflächen am oberen Anzeigerand kli-
cken.
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• Set Normal Scan
Stellt für alle markierten Messgeräte den normalen Abfragemodus ein.

• Set Fast Scan
Stellt für alle markierten Messgeräte den schnellen Abfragemodus ein. Die Rate für die
schnelle Abfrage wird durch die Bevorzugte Abfrage Interleave Rate bestimmt, die unter
Kommunikation Monitor eingestellt wurde.

• Set Off Scan
Stoppt die Abfrage für alle markierten Messgeräte. Dies wirkt sich auf alle angeschlosse-
nen Mini Receiver, Multiscan-Geräte und Datacons sowie auf die DCC Kommunikationen
aus.

• Set Manual Scan
Stellt für alle markierten Messgeräte die manuelle Abfrage ein. In diesem Fall werden
die Messgeräte nur abgefragt, wenn der Bediener einen entsprechenden Befehl ausgibt.

• Set Offline
Stellt für alle markierten Messgeräte unter DCC Comms den Offline-Modus ein. Wirkt
sich nur auf die DCC Kommunikationen aus. Angeschlossene Datacons werden das Sys-
tem weiterhin nach Messgeräten abfragen, aber Tankvision Professional fragt die Data-
cons nicht ab.

Der Abfragestatus aller Messgeräte wird nach jeder Maßnahme automatisch in der
Anzeige Scan Controller aktualisiert.
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16  TAD Maintenance
Das Modul TAD (Tank Additional Data) Maintenance erfüllt drei Aufgaben.

• Tank Mode – Schwankungen im Produktfüllstand oder Volumen des Tanks können
Alarme des Typs Unautorisierte Verpumpung oder Diebstahl auslösen. Diese Alarme
können tankweise vorübergehend deaktiviert werden, ohne dass der Alarm dazu ausge-
schaltet werden muss. Zudem können Tanks in den Background Mode geschaltet wer-
den, in dem Tankdaten nur abgefragt und dann im Hintergrund Scan aktualisiert
werden. Nähere Informationen hierzu siehe Kapitel "Background Mode".

• Tank/Product Status – Über dieses Modul wird festgelegt, ob Verpumpungen für einen
Tank zulässig sind oder nicht, und zwar basierend auf dem Status des Tanks oder des
darin enthaltenen Produkts.

• Tank Pump – Über dieses Modul können Pumpen definiert und Tanks zugewiesen wer-
den.

TAD Maintenance wird über das Menü auf der Home Page aufgerufen: Configuration →
TAD Maintenence.

16.1  Tank Mode

 92 Anzeige Tank Mode im Modul TAD Maintenance

Mithilfe der Tankmodi können Bediener angeben, dass sich der Tank, für den sie zuständig
sind, in einer bestimmten Betriebsart befindet. Über diese Modi kann dann gesteuert wer-
den, wie das System die Tanks behandelt, während sie sich in dieser Betriebsart befinden.
Wenn an einem Standort beispielsweise regelmäßig freies Wasser vom Tankboden abge-
lassen werden muss und zu erwarten ist, dass es während dieses Vorgangs zu einem
Abfallen des Tankfüllstands kommt, dann kann ein Modus mit der Bezeichnung "Wasser-
ablauf-zu" erzeugt werden, der Alarme des Typs Unautorisierte Bewegung vorübergehend
für die Dauer von 2 Stunden unterdrückt.

Wenn der Bediener entscheidet, dass bei einem bestimmten Tank das Wasser abgelassen
werden muss, dann kann der Modus eingestellt und das Ablassen des Wassers gestartet
werden. Nach 2 Stunden wird der Bediener über die Alarm Event Viewer an den Modus
Wasserablauf-zu erinnert. Wenn er den Tank nun wieder in den standardmäßigen stati-
schen Modus zurückversetzt, werden die Alarme des Typs Unautorisierte Bewegung auto-
matisch an dem neuen Füllstand wieder aktiviert. Dadurch benötigt der Bediener keine
Sicherheitsfreigabe, um die Einstellungen für den Alarm Unautorisierte Bewegung zu
bearbeiten, sondern kann die Ausgabe von Alarmen des Typs Unautorisierte Bewegung
temporär unterdrücken.
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Es gibt einen fest vorgegebenen Standard-Tankmodus, der weder Alarme des Typs Unau-
torisierte Bewegung noch Diebstahlalarme unterdrückt oder einen Tank in den Back-
ground Mode versetzt. Dieser Modus kann nicht gelöscht oder bearbeitet werden. Er kann
allerdings vom Benutzer nach Bedarf und Präferenzen umbenannt werden.

16.1.1  Tankmodus hinzufügen
Durch Klicken auf Add wird ein neuer Modus erzeugt, für den die folgenden Attribute kon-
figuriert werden können:
• Name – Dient dazu, eine eindeutige ID für den Modus zu vergeben. Dieser Name wird

bei der Auswahl des Tankmodus verwendet.
• Description – Eine optionale Beschreibung für den Tankmodus. Sie ist nur in der Konfi-

gurationsanzeige sichtbar.
• Alarms Suppressed – Ist diese Option ausgewählt, erzeugen Tanks, die sich in diesem

Modus befinden, keine Alarme des Typs Unautorisierte Bewegung oder Diebstahl.
• Background Mode – Ist diese Option ausgewählt, werden Tanks, die sich in diesem

Modus befinden, nur beim Hintergrund Scan auf Daten abgefragt.
• Default Duration – Ein anderer Wert als Null zeigt an, dass – wenn der Tank in den

Background Mode versetzt wurde – die Unterdrückung von Alarmen des Typs Unautori-
sierte Bewegung oder Diebstahl nur als temporäre Maßnahme gedacht ist. Wird die
Alarmunterdrückung nicht innerhalb der definierten Zeitspanne deaktiviert, wird ein
Alarm ausgegeben, um den Benutzer darauf hinzuweisen, dass sich der Tank noch
immer im Unterdrückungsmodus/Background Mode befindet. Eine Zeitspanne in Minu-
ten (maximal 2880 Minuten, was 48 Stunden entspricht) festlegen, nach deren Ablauf
ein Alarm ausgegeben wird, wenn dieser Modus eingestellt wurde. Wird dieser Wert auf
0 eingestellt, wird der Alarm dadurch deaktiviert. Der Zeitgeber kann nur eingestellt
werden, wenn entweder Alarms Suppressed und/oder Background Mode ausgewählt
ist.

• Exclude Sump from Inventory – Wenn ausgewählt, wird das in der Anzeige Tank Met-
rics eingegebene Tank Sump Volume nicht in die Bestandsberechnung einbezogen.

• Force product level to zero – Wenn diese Option ausgewählt und der Wert des Füll-
standsmessgeräts ungültig ist (DN-Nummer) oder sich das Messgerät am unteren
Anschlag befindet, dann wird der Produktfüllstand für den Tank auf 0 mm eingestellt.
Wenn außerdem der Merker Exclude Sump from Inventory gesetzt ist, dann wird der
Füllstand immer auf 0 mm eingestellt, unabhängig davon, welcher Wert vom Messgerät
zurückgemeldet wurde. Diese Einstellung wird normalerweise für einen Tankmodus ver-
wendet, bei dem angenommen wird, dass der Tank leer ist.

• Automatic Reversion to Default Tank Mode – Wenn ausgewählt, wird der Tankmodus
automatisch auf den Default Mode umgeschaltet, wenn der Produktfüllstand den unter
Empty Tank Threshold eingegebenen Schwellwert mehr als 30 Sekunden lang über-
schreitet. Der Schwellwert wird in der Anzeige Tank Metrics konfiguriert.

16.1.2  Background Mode
Tanks im Background Mode werden nur beim Hintergrund Scan auf Daten abgefragt. Dies
kann nützlich sein, um z. B. die für leere oder inaktive Tanks verwendeten Systemressour-
cen zu reduzieren.

Wenn sich ein Tank im Background Mode befindet, wechselt der auf der Home Page
angezeigte Status des Tanks zu Off Scan.

Auswirkung auf Alarme
Wenn sich ein Tank im Background Mode befindet, werden bestimmte Alarme unter-
drückt.
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HINWEIS
Gefahr durch deaktivierte Alarme
Wenn der Alarm unter Alarm Konfiguration aktiviert ist, überschreibt der Background
Mode die Einstellung und prüft nicht, ob ein Alarmzustand vorliegt.
‣ Ist ein betroffener Alarm aktiv, wenn der Modus eingestellt wird, dann wird der Alarm

deaktiviert und somit aus der Alarmereignisanzeige entfernt.

Diese Funktion ist insbesondere für Standorte nützlich, die die Anzahl der in der Alarm
Event Viewer ausgegeben aktiven Alarme reduzieren möchten.

Folgende Alarme sind betroffen:
• Software Lo Alarm
• Software LoLo Alarm
• Hardware Lo Alarm
• Hardware LoLo Alarm
• Software Temperatur Hi
• Software Temperatur Lo
• Jeder benutzerdefinierte Alarm, der auf niedrigen Füllständen basiert
• Jeder benutzerdefinierte Alarm, der auf der Temperatur basiert
• Programmierbare variable Alarme
• [Alle] Fluss Alarme
• Sollfüllstand erreicht
• Schwimmdach Alarm
• Alarme für "einfache" Bewegungen (keine vollständigen Bewegungen)

• Voralarme 1...4*
• Sollfüllstand überschritten*

Die Alarme für Unautorisierte Bewegung und Diebstahl werden durch das Einstellen des
Background Mode für einen Tank nicht unterdrückt. Wenn der Modus eingestellt wird,
werden die Startwerte aufgezeichnet und initialisieren diese Alarme. Wenn neue Füll-
standsdaten bezogen werden, überprüft das System zwar, ob ein Alarmzustand vorliegt,
allerdings weniger regelmäßig als es normalerweise der Fall ist.

Sollte eine Unautorisierte Bewegung oder ein Diebstahl erkannt werden, muss der
Tankmodus automatisch wieder auf den Standardmodus umgeschaltet werden,
sodass der Tank wieder normal abgefragt wird und alle Alarme wieder eingeschaltet
sind.

Die Alarme Unautorisierte Bewegung und Diebstahl müssen unter Alarm Konfigura-
tion aktiviert sein, damit diese Funktion arbeitet. Diese Funktion arbeitet auch dann
nicht, wenn für Tank Mode ebenfalls die Unterdrückung von Alarmen des Typs
Unautorisierte Bewegung ausgewählt wurde. Der Grund ist, dass diese Funktion durch
die Funktion zur Unterdrückung der Alarme überschrieben wird.

Auswirkung auf "vollständige" Bewegungen
Ein Tank im Background Mode kann in einer geplanten Bewegung verwendet werden.
Wenn auf einem Tank im Background Mode eine Bewegung gestartet wird (Öffnen),
schaltet der Modus automatisch zum Default Mode um. Das Beenden (Schließen) einer
Bewegung auf einem Tank führt jedoch nicht dazu, dass der Modus automatisch zurück-
wechselt.

Auswirkungen auf "einfache" Bewegungen
Wenn eine Bewegung auf einem Tank eingerichtet wird, wechselt der Modus automatisch
zum Default Mode. Durch Beenden (Schließen) einer Bewegung auf einem Tank wird der
Tank nicht automatisch wieder in den Background Mode zurückversetzt.

16.1.3  Tankmodus löschen
Den gewünschten Tankmodus markieren und auf Delete klicken.
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16.1.4  Tankmodus einstellen
Tankmodi werden über die SCADA-Anzeigen angewendet. Es muss ein Datenelement für
den Tankmodus-Dateneintrag konfiguriert werden. Nach der Konfiguration auf das Daten-
element für den Dateneintrag klicken. Es öffnet sich ein Auswahlfenster, in dem der aktu-
elle Tankmodus angezeigt wird.

 93 Tank Mode einrichten

Den gewünschten Tank Mode in der Dropdown-Liste auswählen. Wenn der Modus zur
Alarmunterdrückung ausgewählt ist, wird der Tank Mode Timer Alarm auf den vorkonfi-
gurierten Zeitgeberwert eingestellt. Diese Einstellung kann nach Bedarf bearbeitet werden.

Auf OK klicken, um die Änderungen anzunehmen, oder auf Cancel, um sie zu verwerfen.

Der ausgewählte Tankmodus wird im Feld für die Dateneintrag-Steuerung angezeigt.

Der Zugriff auf die Einstellungen des Tankmodus wird über das Benutzer-Sicherheitssys-
tem gesteuert.

16.2  Tank Status

 94 Konfiguration des Tank Status in TAD Maintenance

Es können Situationen eintreten, in denen es entweder nicht möglich oder nicht wün-
schenswert ist, einen Tank für Produktverpumpungen zu verwenden (z. B. wenn der Tank
gerade gewartet wird). In diesem Fall kann ein Tankstatus eingestellt werden, um Pro-
duktbewegungen auf diesem Tank zu verhindern.

Der Standard-Tankstatus kann weder zum Blockieren von Produktbewegungen verwendet
noch gelöscht werden. Allerdings kann er vom Benutzer nach Bedarf und Präferenzen
umbenannt werden.
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16.2.1  Tankstatus hinzufügen
Durch Klicken auf Add wird ein neuer Status erzeugt. Folgende Attribute konfigurieren:
• Name – Dem Status muss eine eindeutige ID zugewiesen werden. Dieser Name wird bei

der Auswahl des Tankstatus verwendet.
• Description – Eine optionale Beschreibung für den Tankstatus. Sie ist nur in der Konfi-

gurationsanzeige sichtbar.
• Movements Blocked – Wenn diese Option ausgewählt ist, blockieren alle Tanks mit die-

sem Status das Starten von Produktbewegungen. Allerdings wird im Modul für Bewe-
gungen eine Option angeboten, mit der sich diese Einstellung überschreiben lässt.
Hinweis: Dies gilt nur für "vollständige" Bewegungen.

16.2.2  Tankstatus löschen
Den gewünschten Tankstatus markieren und auf Delete klicken.

16.2.3  Tankstatus einstellen
Der Tankstatus wird über SCADA-Anzeigen wie z. B die Einzeltank Ansicht zugewiesen.
Dazu muss ein Datenelement für den Tankstatus-Dateneintrag konfiguriert werden. Nach
der Konfiguration auf das Datenelement klicken. Es öffnet sich ein Auswahlfenster, das
den aktuellen Tank Status anzeigt.

 95 Einrichten des Tank Status

Den gewünschten Status in der Liste auswählen und auf OK klicken.

Der ausgewählte Tank Status wird im Feld für die Dateneintrag-Steuerung angezeigt.

Der Zugriff auf die Tankstatus-Einstellungen wird über das Benutzer-Sicherheitssystem
gesteuert.
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16.3  Produkt Status

 96 Konfiguration des Product Status in TAD Maintenance

Es können auch Situationen eintreten, in denen es nicht möglich oder nicht wünschens-
wert ist, ein bestimmtes Produkt in einem Tank zu verwenden (wenn das Produkt z. B. ver-
unreinigt ist). In diesem Fall kann ein Produktstatus verwendet werden, um Bewegungen
des Produkts zu verhindern.

Der standardmäßige Produktstatus ist fest vorgegeben: Dieser Status kann weder gelöscht
noch bearbeitet und auch nicht zum Blockieren von Produktbewegungen verwendet wer-
den. Allerdings kann er vom Benutzer nach Bedarf und Präferenzen umbenannt werden.

16.3.1  Produktstatus hinzufügen
Durch Klicken auf Add wird ein neuer Status erzeugt. Folgende Attribute konfigurieren:
• Name – Dem Status muss eine eindeutige ID zugewiesen werden. Dieser Name wird bei

der Auswahl des Produktstatus verwendet.
• Description – Eine optionale Beschreibung für den Produktstatus. Sie ist nur in der Kon-

figurationsanzeige sichtbar.
• Movements Blocked – Wenn diese Option ausgewählt ist, dann blockieren alle Pro-

dukte mit diesem Status das Starten von Produktbewegungen. Im Modul für Bewegun-
gen wird allerdings auch eine Option angeboten, mit der sich diese Einstellung
überschreiben lässt.
Hinweis: Dies gilt nur für "vollständige" Bewegungen.

16.3.2  Produktstatus löschen
Den gewünschten Produktstatus markieren und auf Delete klicken.

16.3.3  Produktstatus einstellen
Produktzustände werden über SCADA-Anzeigen wie z. B. die Einzeltank Ansicht zugewie-
sen. Dazu muss ein Datenelement für den Produktstatus-Dateneintrag konfiguriert wer-
den. Nach der Konfiguration auf das Datenelement für den Dateneintrag klicken. Es öffnet
sich ein Auswahlfenster, das den aktuellen Product Status anzeigt.

Den gewünschten Status in der Liste auswählen und auf OK klicken.

Der ausgewählte <notranslate translate="no">Product Mode</notranslate> wird im
Feld für die Dateneintrag-Steuerung angezeigt.

Der Zugriff auf die Einstellungen des Produktmodus wird über das Benutzer-Sicherheits-
system gesteuert.
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16.4  Tank Pump

 97 Konfiguration von Tank Pumps in TAD Maintenance

Diese Anzeige gibt an, welche Pumpe aktuell mit einem Tank verbunden ist. Diese Anzeige
dient nur zu Informationszwecken; es ist nicht möglich, die Pumpen physisch über diese
Anzeige zu steuern.

16.4.1  Pumpe hinzufügen
Durch Klicken auf Add wird eine neue Pumpe erzeugt. Folgende Attribute konfigurieren:
• Name – Der Pumpe muss eine eindeutige ID zugewiesen werden. Dieser Name wird ver-

wendet, um die Pumpe einem Tank zuzuweisen.
• Description – Optionale Beschreibung für die Pumpe.
• Tank ID – Den Tank auswählen, an den die Pumpe angeschlossen ist. Dieses Feld leer

lassen, wenn die Pumpe aktuell an keinen Tank angeschlossen ist.

Eine Pumpe kann immer nur an einen Tank angeschlossen sein. Umgekehrt können
allerdings an einem Tank mehrere Pumpen angeschlossen sein.

16.4.2  Pumpe löschen
Die gewünschte Pumpe markieren und auf Delete klicken.

16.4.3  Pumpen zu Tanks zuordnen
Pumpen werden Tanks über die Einzeltank SCADA-Anzeigen zugewiesen. Zunächst muss
ein Datenelement für den Pumpen-Dateneintrag konfiguriert werden (in allen SCADA-
Anzeigen wird immer nur je ein solches Datenelement unterstützt).

Nachdem das Datenelement konfiguriert wurde, die Single Tank Overview für den Tank
öffnen, zu dem eine Pumpe hinzugefügt werden soll, und dann auf das Datenelement für
den Pumpen-Dateneintrag klicken. Es öffnet sich ein Auswahlfenster, in dem alle Pumpen
und ihre aktuellen Zuordnungen angezeigt werden.
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 98 Pumpen einem Tank zuweisen/freigeben

Die Pumpe(n), die dem aktuellen Tank zugewiesen werden soll(en) markieren und auf OK
klicken. Wenn eine oder mehrere der zugewiesenen Pumpen bereits einem anderen Tank
zugewiesen waren, werden sie von diesem Tank entfernt, da Pumpen immer nur einem
Tank und niemals mehreren Tanks gleichzeitig zugewiesen sein können.

Die ausgewählte Pumpe wird im Feld für die Dateneintrag-Steuerung angezeigt. Wurden
einem Tank mehr als eine Pumpe zugewiesen, wird nur die erste Pumpe, gefolgt von
einem Plus-Zeichen (+), aufgeführt, um anzuzeigen, dass dem Tank weitere Pumpen zuge-
wiesen sind. Mit der Maus über das Feld für die Dateneintrag-Steuerung fahren, um eine
vollständige Liste der Tanks anzuzeigen.

Der Zugriff auf die Pumpeneinstellungen wird über das Benutzer-Sicherheitssystem
gesteuert.

16.4.4  Pumpenzuweisung aufheben
Die Single Tank Overview für den Tank öffnen, von dem eine Pumpe entfernt werden
soll, und dann auf den Datenelement für den Pumpen-Dateneintrag klicken. Es öffnet sich
ein Auswahlfenster, in dem alle Pumpen und ihre aktuellen Zuordnungen angezeigt wer-
den.

 99 Pumpen einem Tank zuweisen/freigeben

Pumpen, die dem Tank aktuell zugewiesen sind, werden markiert angezeigt. Um eine
Pumpe von einem Tank zu entfernen, die Taste Strg drücken und gleichzeitig mit der
Maus auf die gewünschten Pumpen klicken, um die Markierung zu entfernen.
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